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Version comparison 

The following table provides an overview of the different functions and features provided with 

the different versions of the software: 

 

Function/feature Essential version 

(Freeware) 

Professional version (Trial 

period: 60 days + 30 on 

request 

Professional version with 

reporting option 

Supported databases: 
 

 

 

 

 

Postgre SQLTM X X X 

OracleTM  X X 

Microsoft SQL ServerTM  X X 

Supported devices:   
 

Ecograph RSG20  X X 

Ecograph A RSG22  X X 

Ecograph C RSG24  X X 

Ecograph T RSG30 X X X 

Ecograph T RSG35 X X X 

Memograph RSG10  X X 

Memograph S RSG12  X X 

Memograph M RSG40 X X X 

Memograph M RSG45 X X X 

EngyCal RH33  X X 

EngyCal RS33  X X 

RA33  X X 

Liquiline CM44x  X X 

Liquistation CSFxx  X X 

Liquiline System CA80xx  X X 

User administration  X X 

Multiple access to the 

database from different PCs at 

the same time 

 X X 

Data of multiple devices in 

one template 
 X X 

Automatic readout X X X 

Automatic deletion X X X 

Automatic binary export  X X X 
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Automatic XLS/CSV export   X X 

Automatic PDF export   X X 

Export ready for eSight 

(energy monitoring software) 
 X X 

Import of ReadWin 2000 data X X X 

Online visualization of 

instantaneous values ("Live 

Data") 

 X X 

Visualization of standard 

reports 
  X 

Visualization of customer-

specific reports 
  X 

E-mail notification  X X 

Update search  X X 

Please note that in order to use the Demo version as a Professional or Essential version (freeware), it must be activated 

after the trial period has elapsed. 

It is possible to switch from the Essential version (freeware) to a commercial version at any time by entering a software 

ID and then activating the product. 

Switching from the Demo version to the Essential version (freeware) may result in certain functions no longer being 

available. For example, templates created with data from multiple devices will no longer work and neither will 

automatic exports. Devices that are included only in the Professional version can no longer be read out in the Essential 

version (freeware). 
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1. Introduction 

1.1 Preface  

The Reporting Software offers central data management and visualization of recorded 

data.  

This allows complete documentation of the data of a measuring point, e.g.: 

• Measured values 

• Diagnostic events 

• Reports 

The evaluation software stores data in a SQL database. The database can be operated either 

locally or in a network (client /server). 

NOTICE   
When using the Essential version, a database stored in the network cannot be accessed 

simultaneously by multiple PCs. 
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1.2 Notes on safety conventions and icons  

 
NOTICE  

Note: Failure to observe instructions can damage the device or lead to a device malfunction! 

 

 
Tip: Indicates additional information. 

1.3 Safety instructions   

NOTICE  
Observe the following points: 

 The manufacturer accepts no liability for damages resulting from incorrect use or use other 

than that designated. 

 Observe all safety instructions in the Operating Manuals for the devices connected to the 

system. 

 Installation, commissioning, operation and maintenance of the measuring system must be 

carried out by trained, skilled personnel authorized to perform such work by the facility's 

owner-operator. The skilled personnel must have read and understood these Operating 

Instructions and follow the instructions they contain. 

1.3.1 Liability disclaimer  

This software and the corresponding documentation can be revised or updated by the 

manufacturer without prior notice. In case of a revision or update, the end user has no claim to 

automatic delivery free of charge of the revised or updated software or the corresponding 

documentation. 

It is at the manufacturer's discretion to decide whether or not a revision or update of the 

software is carried out, and when. 

The documentation includes the printable version of the Operating Manual and brief operating 

instructions. The printable version of the Operating Manual is valid for the version specified on 

the cover sheet. The version number of the currently installed version is provided in the “Help” 

menu item. 

Likewise, there is no warranty that this software will function on all hardware platforms or in 

conjunction with other software. We exclude all further claims due to any damages that occur. 

NOTICE  
The complete end-user license agreement can be called up anytime after installation in the main 

menu under "Help -> License agreement". 

 

1.3.2 Safety instructions for Memograph M RSG45 with FDA approval  

NOTICE  
The following information concerning FDA 21 CFR Part 11 compliance is the responsibility of the 

user: 

o Termination of the automatic system service must be regulated by Windows user rights. 

o If a user does not log out of the software, a screensaver is automatically activated via 

Windows system settings. 

o The software may only be operated via Windows login. The user must secure (lock) the 

computer when leaving the PC. 

o If the administrator has forgotten the password, a time-limited master password is 

permitted. This is sent to the client on request and following authorization.  

o It is possible to use and operate the software without identification and password 

protection. The client is responsible for the use of the software. 
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o Select "Enable user management " and "Password protection compliant to FDA21 CFR 

PART 11" in the software under "Extras -> Settings -> User administration". 

o To prevent misuse of identity, the password must be changed when the user logs in for 

the first time (configurable).  

o The period of password validity can be configured. This is the responsibility of the 

administrator. 

o As the PC time is used for the PC software audit trail, it is possible to manipulate the 

time stamp. The operator is responsible for any changes to the PC time. 

o User administration must be active in order to record the ID and user name in the audit 

trail. 

o The user must perform data backup and/or preventive maintenance regularly. 

o After printing out data, the user must check that the printout content is correct by 

manually comparing the data displayed on the screen against the printout and, where 

necessary, confirm the integrity of the data by providing a separate "non-electronic" 

signature on the printout. 

o If the printer settings are changed to a printer that is not available, there is no printout! 

The software cannot configure the device or set device parameters.  

Exception: The software can synchronize the device time; the PC time and the device 

time may only deviate from one another within a certain tolerance range. Otherwise the 

time is not accepted for the device. The operator is responsible for ensuring the PC time 

is correct. 

o A regular review of the error list (log file) is recommended. The 

"WindowsServiceLog.txt" is generated under "Automatic -> Job Type: Event view". 

o When printing out a visualization, it is possible to restrict the output of values, diagrams, 

events and audit trail entries. Changes to the standard configuration are the 

responsibility of the user and are recorded in the audit trail. 

 

1.3.3 Register trademarks  

Pentium
TM

: Registered trademark of the Intel
TM

 Corporation 

AMD
TM

: Registered trademark of Advanced Micro Devices 

Windows
TM

, Vista
TM

, Microsoft SQL Server
TM

: Registered trademarks of the Microsoft
TM

 

Corporation 

Oracle
TM

: Registered trademark of the Oracle
TM

 Corporation 

CodeMeter®: Registered trademark of WIBU SYSTEMS 

1.4 Hardware and software requirements 

The following requirements must be met before installing and operating the PC software:  

1.4.1 Hardware: 

1.4.1.1 Hardware requirements for the FDM software 

 PC with Pentium 4 (≥2 GHz),  

 PC with Pentium M (≥1 GHz), 

 PC with AMD (≥1.6 GHz) 

 Minimum 1 GB RAM cache 

 Minimum 20 GB free disk space 

 Screen resolution of at least 1024 x 800 pixels 

 CD/DVD drive 
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1.4.1.2 Hardware requirements for the reporting server 
 Installation of the reporting server (the BPI Dashboard) requires approximately 1 GB of hard disk 

memory. Additional memory is required for report projects. 
 The dashboard's Tomcat service requires approx. 1.5 GB of working memory. If the server is only used 

for reporting, 4 GB of working memory is sufficient. If other applications are operated here, this must 
be factored into the size of the working memory. 

 

1.4.2 Software: 

1.4.2.1 Operating system/software for the FDM software 

 Microsoft Windows Server 2003 R2 SP2 Standard, Enterprise (32 bit)  

 Microsoft Windows Server 2008 (32/64 bit) 

 Microsoft Windows Server 2012 (64 bit) 

 Microsoft XP SP3 (32 bit)  

 Microsoft Vista (32/64 bit)  

 Windows 7 (32/64 bit) 

 Windows 8, Windows 8.1 (32/64 bit) 

 Windows 10 (32/64 bit) 

 Windows .NET 2.0 SP1 

1.4.2.2 Operating system for the reporting server 

 Windows 7 (64 bit) 

 Microsoft Windows Server 2008 (64 bit) 

 Microsoft Windows Server 2012 R2 (64 bit) 

1.4.3 User rights for installation 

 Logged in with Windows administrator user rights 

 User Account Control (UAC) confirmation if enabled  

1.4.4 Changes made during the installation: 

1. Installation directory added 

2. Files copied to installation directory 

3. Application directory added 

 Windows 2000: %system drive%\Documents and Settings\All 

Users\Application Data\Endress+Hauser  

 Windows XP: %system drive%\Documents and Settings\All Users\Application 

Data\Endress+Hauser  

 Windows Server 2003: %system drive%\Documents and Settings\All 

Users\Application Data\Endress+Hauser  

 Windows Vista, Windows 7, Windows 8 and Windows Server 2008: %system 

drive%\ProgramData\Endress+Hauser 

4. Windows .NET 2.0 SP1 installed (optional) 

5. Field Data Manager Windows Service (FDM WS) installed (autorun, optional) 

6. Field Data Manager Tray Icon Application (FDM TI App) installed (autorun, 

optional) 

7. PostgreSQL server installation (optional) 

8. Installation of the WIBU CodeMeter license server 

9. Program shortcut created 
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10. FrameApplicationTomcat installed (Reporting components, optional) 

11. Registry entries 

12. Installation log file created (%tmp%)  

 

1.4.5 Components 

1.4.5.1 FDM TI App is executed with the user rights of the logged-in user 

Read and write access to the following directories (version 1.01.01.06 and higher): 

 Installation directory 

 Application directory 

 Allocated network drives (optional) 

1.4.5.2 FDM WS is executed with the local system account 

Read and write access to the following directories (version 1.01.01.06 and higher): 

 Installation directory 

 Application directory 

 Allocated network drives (optional) 

1.4.5.3 FDM application is executed with the user rights of the logged-in user 

Read and write access to the following directories (version 1.01.01.06 and higher): 

 Installation directory 

 Application directory 

 %tmp%  

1.4.5.4 The reporting service (FrameApplicationTomcat) is executed with the local system account. 

Read and write access to the following directories: 

 Installation directory 

 C:\ProgramData\ 

1.4.6 Firewall 

 Communication port used for field devices (default: TCP port 8000, incoming/outgoing) 

 Microsoft SQL database server (default: TCP 1433, incoming/outgoing) 

 PostgreSQL database server (default: TCP 5436, incoming/outgoing) 

 Oracle database server (default: TCP 1521, incoming/outgoing) 

 LDAP network service (optional, default: TCP/UDP port 389, incoming/outgoing) 

 Network printer (optional) 

 Reporting server  FDM: (default: TCP port 8080) 

 Reporting server database port (default: TCP port 1552) 

 Reporting server AJP port (default: TCP port 8052) 

 Reporting server Tomcat shutdown port (default: TCP port 8012) 

1.4.7 User 

See 1.4.5 Components 

1.4.8 User Account Control (UAC) 

No special authorization is required after installation (unless the FDM user will start/stop FMD 

WS). 
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1.5 Installation / Uninstalling 

NOTICE  
You can find a detailed description of the installation in the Brief Operating Instructions 

supplied. 

 Insert the DVD. 

 If autostart is enabled, the installation is started automatically; otherwise 

 Start the "Setup.exe" from the DVD.  

 Follow the instructions of the installation program. 

If you confirm the installation of the automatic component, an additional Windows system 

service is set up. This system service enables you to trigger and control automatic actions 

through the Reporting Software. These include, for example, automatic device read-out, 

automatic printing of reports, and automatic report generation (see Section 5.4. "Automatic").  

 

The following databases are supported: 

• PostgreSQL (for the Essential, Demo and Professional versions) 

You can install and use the free PostgreSQL database provided on the installation DVD. No 

manual installation and configuration is necessary to do so. The database is configured 

automatically during the installation. 

• Oracle (for the Demo and Professional version) 

Version 8i or higher. Please contact your database administrator to set up the Reporting 

Software with the Oracle database. You can find a detailed description of the installation in the 

Brief Operating Instructions supplied. 

• Microsoft SQL Server (for the Demo and Professional version) 

Version 2005 or higher. Please contact your database administrator to set up the Reporting 

Software with the Microsoft SQL Server. You can find a detailed description of the installation in 

the Brief Operating Instructions supplied. 

1.5.1 Software license  

1.5.1.1 License server 

From version 1.4.0, the WIBU CodeMeter is installed as part of the setup. CodeMeter manages 

the licenses for this software as well as software tools from other manufacturers. 

1.5.1.2 Replacing hardware 

The license technology used supports your productivity by allowing up to approx. 30% of the 

client hardware to be replaced without the license losing its validity. 

1.5.1.3 License violation / Blocked license 

License abuse and the replacement of more than 30% of the hardware will result in a license 

violation. In this case, the FDM can no longer be operated and no license operations are 

supported. Please take this into account in the case of maintenance and disaster recovery. 

1.5.1.4 Blocked license container 

License abuse results in the license container being blocked. Please note that this means that all 

Endress+Hauser applications activated on the client lose their valid license and can no longer be 

used. 

1.5.1.5 Replacement license 

Provided that you have not used up your allocation of activations, you will automatically receive 

an additional activation every 24 months. In the event that disaster recovery is performed on 

your client and you are unable to return the license, you will be able to re-activate the FDM 

independently and without having to contact Endress+Hauser. 
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1.5.1.6 Setting up client again 

If there are no changes to the hardware, the FDM can be activated by re-installing the old 

activation file ('*.EHu). 

1.5.1.7 Virtual environments 

The FDM supports virtual environments on the same host if "moved". The copying (moving) of 

a VM image within the same host or to another host is not supported.   

1.5.1.8 Software backup 

Backup and restore of licenses is not supported. As a rule, a license can no longer be used after a 

restore! Use the "License server" function to transfer the licenses to another host if you need to 

back up the computer. 

 

1.5.2 Software update/upgrade  

You can find a detailed description of the installation in the Brief Operating Instructions supplied. 

1.5.3 Uninstalling software  

If you wish to uninstall the software, proceed according to the following steps:  

1. Return the license (see section 1.7.2) 

2. Deactivate Automatic Services, terminate Tray Icon application and analysis software 

3. In the Control Panel, select the "Field Data Manager x.x.x." software under "Uninstall or 

change a program". 

4. Select "Uninstall" and follow the instructions. 

NOTICE  
The WIBU CodeMeter remains on the system and is not uninstalled. 

 

1.6 Starting the program, selecting the operating language  

Under "Start -> Programs", you will find the newly installed "Field Data Manager Software" 

program. Start the program and, if necessary, change the operating language under "Extras -> 

Settings -> Language". The changed operating language is applied after the program is restarted.  

1.7 License management and software activation  

NOTICE  
In order to use the Professional version or reporting function, a valid software ID is required and 

the software must be activated.  

If there is no software ID, you will be notified of this when starting the program: 

 

Enter your software ID here. You will find this information on the sleeve of the DVD. The 

software can then be activated.  
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1.7.1 Activating software  

To activate the software, proceed as follows:  

1. Click the menu item "Help -> License information" 

2. Click "License information". 

 

 

3. Click "Activate software". 

 

NOTICE  
To activate the software, you will need an account for the Endress+Hauser Software 

Portal at:  

https://software-products.endress.com 

 

The Software Portal allows you to manage licenses for Endress+Hauser products. If you 

do not know the details required to log in to the Software Portal, please contact the 

person responsible for licenses in your company, or click "Create account": 

 

 

4. Click "Activate now". 
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NOTICE  
Manual activation (offline activation) 

In the event that online activation is not possible, the program switches automatically to manual 

activation. A dialog box for manual activation opens. Follow the instructions.  
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1.7.2 Returning the license  

If you wish to install the software on a new computer, for example, you must return the already 

used license to the Endress+Hauser Software Portal.  

NOTICE  
Once the license has been returned, the software can no longer be used on this computer. 

Once it is installed on a new computer, the license can be reactivated and used again.  

To return the license, proceed as follows:  

1. Click the menu item "Help -> License information" 

2. Click "License Information". 

 

 

3. Click "Return license" to open the following dialog box: 

 

 

4. Enter your login details and confirm your login information by clicking on "Return 

license" again. 
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You will receive confirmation that the license has been returned successfully.  

 

NOTICE  
Manual return of license (offline mode) 

In the event that online license returns are not possible, the program switches automatically to 

manual license returns. A dialog box for manual license returns opens. Follow the instructions. 
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1.7.3 Upgrading and updating license  

1.7.3.1 Upgrading license  

If you require additional functions, modules (e.g. reporting) or additional users (multi-user 

license), your license can be upgraded accordingly. 

1. Please contact your Endress+Hauser sales office. 

2. Order the license upgrade suited to your needs. Endress+Hauser upgrades your license 

and sends you confirmation of the license upgrade. 

3. Update your license when you receive confirmation of the license upgrade. 

4. Check your license under "Help -> License Information -> License Information" 

1.7.3.2 Updating license  

A license update means that you have updated your contract with the Endress+Hauser sales 

office and purchased new functions (e.g. reporting function) or additional licenses.In order to 

activate the new components of the contract, the license must simply be updated.  

NOTICE  
Updating the license does not require that the software be re-installed.  

To update the software with the license upgrade, proceed as follows:  

1. Click the menu item "Help -> License Information" 

2. Click "License Information". 

 

 
 

3. Click "Update license". 

 

NOTICE  
To update the license, you will need the login details for your account with the 
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Endress+Hauser Software Portal at:  

https://software-products.endress.com. 

If you do not know the details required to log in to the Software Portal, please contact 

the person responsible for licenses in your company: 

 

 

4. Click "Update license". 

You will receive confirmation that the update was successful.  

 

NOTICE  
Manual license update (offline mode) 

In the event that online updates are not possible, the program switches automatically to manual 

license updates. A dialog box for manual license updates opens. Follow the instructions.  
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1.7.4 Searching for updates The software provides the option to search for updates.  

NOTICE  
This function is available exclusively in the Professional version. 

If an update is available and you wish to update your version, please contact your 

Endress+Hauser sales office. 

1. Click "Help -> License information". The following screen appears: 

 

 

2. Click "Check for update". 

3. A connection to the Endress+Hauser server is established and a web browser window 

opens. A message appears in this window informing you whether or not updates are 

available. 
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1.8 Getting started, switchover from ReadWin 2000  

NOTICE  
In contrast to ReadWin 2000, the Reporting Software does not support device configuration.  

All the readout functions of ReadWin 2000 have been merged into the "Data Readout" task in the 

Reporting Software. Here, the data can be read out via an interface - i.e. connected to the device 

online - or via a data storage medium.  

In addition, the functions for displaying the read-out data have been merged into one 

"Visualization" task in the Reporting Software. It is possible to select the display mode (bar graph 

– histogram, line chart or table) and visualize the data directly via the chart settings or channel 

settings (as users will know from Excel for example). This means that individual channels can be 

displayed differently in a single chart. 

Functions in ReadWin 2000 compared to the new Reporting Software: 

 

In the Reporting Software, the device settings (communication, automatic functions) are 

configured via the plant tree structure by right-clicking the device or directly in the individual 

visualization steps or when reading out the device data. 

As with ReadWin 2000, the settings for configuring the automatic function are grouped in one 

point under "Data Management –> Automatic". 

The automatic function is set up as a system service and runs in the background. The Reporting 

Software does not necessarily have to be started to run an automatic task. 

1.9 Applying the Plant View from FieldCare  

To apply the Plant View from FieldCare, you have to first export the view from FieldCare or save 

it as a CSV file. For this purpose, FieldCare enables you to export the Plant View in CSV format 

via "File -> Import/Export -> Export as CSV" and to store it at a location to be defined. This 

device tree can then be adopted in the Reporting Software. 

The Reporting Software enables you to apply an existing, saved device tree or an existing Plant 

View from another program (e.g. FieldCare). This functionality is provided in the "Data 

Management -> Plant View" task. 

Pressing the "Box with arrow"  icon opens the menu structure of the computer. Select the 

storage location and the corresponding CSV file of the Plant View. Then, the tree structure is read 

into the database and stored there. The same functionality is provided by selecting the enterprise, 

then right-clicking and selecting "Import Plant View" (see Section 5.1 Data management -> Plant 

view) . 

NOTICE  
As the Essential version does not support all devices, only data from supported devices can be 

imported in this version! 
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1.10 Importing data from ReadWin 2000  

To import data from ReadWin 2000 to the SQL database of the Reporting Software in a tamper-

proof manner, the process begins with the secure data export from ReadWin 2000. For this 

purpose, the data for the corresponding devices are exported to a storage medium or drive (Extras 

-> Store/Save Measured Values): 

 

 
 

 

 

Subsequently, the data of the individual devices are imported into the SQL database via the 

import function of the Reporting Software. For this purpose, select the "rsd" data format. See the 

description of the import function in Section 5.3 on page 76. 
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1.11 The main window  

The general layout of the Reporting Software user interface is illustrated in the graphic below: 

 

 

1.11.1 Main menu  

The main menu at the top contains the menu bar with function groups for software settings. 

File -> End program 

View -> View settings 

Extras -> Settings for the database, language, user administration, audit trail 

Help -> Start online help, software information, change/activate license 

1.11.2 Toolbar  

The toolbar in the dockable window allows quick access to functions such as printing, 

saving or the online help. 

1.11.3 Task pane  

The task pane is located on the left. The task pane can be displayed and hidden via the "View" 

function in the main menu. Click on a task to open the task. The functions contained are 

displayed: 

Read out data -> read out data via mass storage or online connection to the device 

Visualization -> open, edit, delete or create a new visualization template 

Reporting (optional) -> create, open or delete dashboards/reports, assign dashboards, manage 

report projects 

 

Data management -> plant view, device data export and import 

1.11.4 Main window  

The main window contains the dockable windows. Tabs are displayed when more than one 

dockable window is present.  
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1.11.5 Dockable window  

A dockable window can be docked in the main window or can “hover” outside the window. It is 

possible to position the window without blocking other windows. There is a button for closing 

the window (X) on the right.  

Every dockable window has a title bar (at the top of the window) with the name of the sub-

element 

and the associated icon on the left-hand side. A toolbar containing window-specific icons, quick 

information and functionalities is located below the title bar. The main area of the dockable 

window starts below the toolbar.  

1.11.6 Status bar  

The status bar shows the login status and other information.  

1.11.7 Splitter  

The splitter separates the task pane from the main window. The splitter can only be moved if the 

task pane and main window are visible. Change the position of the splitter to change the size of 

the task pane and main window.  

 

2. Task pane -> Read out data 

Read out data and store them to the database – "Read Out Data" 

By selecting the "Read Out Data" task from the task pane, you can carry out the configuration, 

read out measurement data or other data stored in the device and simultaneously store the data 

to a database so that they are tamper-protected.  

The free PostgreSQL  database supplied with the Reporting Software or existing SQL databases 

(Oracle and Microsoft SQL server) can be used as the target database. For the settings for 

selecting the database, refer to Section 6.1.2 . 

NOTICE  The Essential version only supports the free PostgreSQL database provided. 

In the "Read Out Data" task, the two types of readout, "Mass Storage" or "Online Connection", 

are available.  

Clicking the corresponding icon opens an additional working window in the right half of the 

screen. This window guides you step-by-step through the items to be defined.  

Icons in the upper area help you navigate through the individual steps: 

  Green arrow pointing left: Corresponds to the "Back" button; jump to the previous 

definition step. 

 Green arrow pointing right: Corresponds to the "Next" button; jump to the next 

definition step. 

 Question mark: Help; call up the help function for the corresponding definition step. 

 

2.1 Read out data -> Mass storage 

In this task, you can read out and store data (binary *.dat) from storage media such as SD cards, 

USB sticks or a drive. 

2.1.1 Step 1 of 3: Select data source  

Where are the data to be read out stored? 

Select the data source. 

The "…" button opens the folder and interface structure of Explorer and the workstation. 

The drop-down menu suggests storage locations and storage media that were already used earlier: 
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After selecting the data source or storage location of the data to be read out, you can jump to the 

next step using "Next". 

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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2.1.2 Step 2 of 3: Select device  

From which device are the data to be read out? 

In this second step, the corresponding devices and the data time range are selected: 

 

 

The "Devices" area lists the devices found on the storage medium. 

There, you can select a device or devices by checking them. This means that you do not have to 

read out the entire data volume of the storage medium. 

You can select them all using the "Select All" button. "Unselect All" removes the selection. 

By checking the box for "Delete Files after Import", the selected data are deleted from the data 

storage medium as soon as these data have been stored successfully to the database.  

NOTICE  Once data are deleted from the storage medium, this cannot be undone! 

When you have finished selecting the devices to be read out, define the volume of data to be 

stored. This data is then read out in the next step. 

Finish your selection by pressing "Next". 

You can return to the previous view by selecting "Back".  

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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2.1.3 Step 3 of 3: Reading data  

The defined data are read out and stored to the database. 

A progress bar shows the progress in % and displays the estimated time remaining. The duration 

of the read-out process depends on the data volume and the storage medium used. You can stop 

the action during this procedure by pressing the "Cancel" button. You can return to the previous 

view by selecting "Back". 

Once the action has been completed, a confirmation text appears below the progress bar: 

 

 

The data defined in steps 1 and 2 have now been read in from the storage medium successfully 

and stored to the database. 

If, in step 2, the "Delete Files after Import" check box was ticked, the stored data will also have 

been successfully deleted from the storage medium.  

Select "Close" to end the process. The window closes. 
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2.2 Read out data -> Online connection  

2.2.1 Read data from a device which has already been created 

2.2.1.1 Step 1 of 5: Select device 

From which device do you want to read out? 

NOTICE  Not all devices are supported in the Essential version. Unsupported devices which 

have already been installed are displayed along with their configuration. However, the available 

functionality cannot be applied to them. 

The device to be read out is selected in step 1. The view shows the Plant View already created. 

This view can be restructured and expanded (see 5.1 Data management -> Plant view)"". 

 

The "Memory card in device" and "Device memory" buttons are used to select the device data to 

be read out.  

"Memory card in device": The data on the memory card of the selected device are read out. 

"Device memory": The data in the internal memory of the selected device are read out. 

As soon as the selected data have been stored successfully to the database they are deleted from 

the device memory or from the memory card in the device. 

NOTICE  
Once data are deleted, this cannot be undone! 

You can activate an immediate readout by right-clicking and then selecting "Read Out Data" or by 

selecting "Next". Then, step 5, "Read Out Data", opens. 

Reading out via a communication interface requires a defined communication with the device. 

Communication can be configured or modified via data management, when creating devices in 

the Plant View, or in this step. 
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Selecting the device and right-clicking, then selecting "Configure Interface..." opens the 

Communication Settings: 

 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

2.2.1.2 Step 2 of 5: Configure device settings  

Step 2 is skipped automatically, as the device settings are already stored in the saved device. 

2.2.1.3 Step 3 of 5: Configure automatic  

Step 3 is skipped automatically, as the automatic configuration is already stored in the saved 

device. 
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2.2.1.4 Step 4 of 5: Device information  

If "Readout memory card in device" is selected in step 1: 

The software tests the connection to the device and loads the specific device information. 

The screen displays the data on the memory card. These data can be individually selected for 

readout: 

 

To modify the selected device or the communication specifications, you can return to the 

previous steps via "Back". 

Clicking the "Next" button activates reading out of data from the device. 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

If "Readout device memory“ is selected in step 1: 

Step 4 is skipped automatically, and all the data are read out of the device memory. 
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2.2.1.5 Step 5 of 5: Read out data  

The defined data are read out and stored to the database. 

A progress bar shows the progress in % and displays the estimated time remaining. The duration 

of the read-out process depends on the data volume and the storage medium used. You can stop 

the action during this procedure by pressing the "Cancel" button. You can return to the previous 

view by selecting "Back". 

Once the action has been completed, a confirmation text appears below the progress bar: 

 

 

The defined data have now been read out of the device successfully and stored to the database. 

The stored data have also been successfully deleted from the device memory. 

Select "Close" to end the process. The window closes. 
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2.2.2 Reading out a new device not yet created  

2.2.2.1 Step 1 of 5: Select device or create new device 

The view shows the Plant View already created. This view can be restructured and expanded (see 

5.1 Data management -> Plant view)"".  

If the device to be read out is not yet created, you can create a new device using the "New 

Device" button. Pressing this button jumps to step 2. 

 

 

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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2.2.2.2 Step 2 of 5: Configure device settings 

In step 2, the new device to be created and read out is defined. 

To so do, define the interface to the device, the device type and the memory to be read out 

(device memory, mass storage) in the "Select Source" area. 

Automatic device detection: In the case of automatic device detection, the device type is 

automatically detected when the required interface parameters are specified. Automatic detection 

is enabled as standard. If automatic device detection is disabled, a drop-down list of all supported 

device types appears once the interface is specified.  

Then, in the lower area, define the communication/interface in greater detail. 

  

By checking the box for "The device is read out by more than one Reporting Software", it is 

possible to read out up to 4 PCs. 

Checking the box for "Repeat readout periodical" enables regular automatic readout. You can 

define the automatic function for the corresponding device in the next step or via the automatic 

configuration 7.3 ). The automatic readout requires a continuous connection to the device. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  
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2.2.2.3 Step 3 of 5: Configure automatic  

NOTICE  
This is possible only if "Repeat readout periodical" has been selected in the previous step. 

 

Data read out: 

The regularity of the automatic function is defined here. For this purpose, the "Active" check box 

must be selected. 

Interval: How often does the export take place? 

Depending on the selected interval, define the repetition, start day and start time (see Section 

7.3). 

Time synchronize: 

Here, you can synchronize the device time with the system time of the computer. 

To define the regularity of the synchronization, the "Active" check box must be selected (see 

Section 7.5).  

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  
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2.2.2.4 Step 4 of 5: Device information 

This tests the communication defined for the device. 

The software tests the connection to the device and loads the specific device information. 

In addition, if "Readout memory card in device“ is selected (in step 2), the data which are 

contained on the memory card and which can be individually selected for readout are displayed: 

 

To modify the selected device or the communication specifications, you can return to the 

previous steps via "Back". 

Clicking the "Next" button activates reading out of data from the device. 

As soon as the selected data have been stored successfully to the database they are deleted from 

the device memory or from the memory card in the device. 

NOTICE  
Once data are deleted, this cannot be undone! 

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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2.2.2.5 Step 5 of 5: Read out data  

The defined data are read out and stored to the database. 

A progress bar shows the progress in % and displays the estimated time remaining. The duration 

of the read-out process depends on the data volume and the storage medium used. You can stop 

the action during this procedure by pressing the "Cancel" button. You can return to the previous 

view by selecting "Back".  

Once the action has been completed, a confirmation text appears below the progress bar: 

 

The defined data have now been read out of the device successfully and stored to the database. 

The stored data have also been successfully deleted from the device memory or the memory card 

in the device. 

Select "Close" to end the process. The window closes. 
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3. Task pane -> Visualization 

In the Task pane, the "Visualization" task includes all items that pertain to displaying the stored or 

current data. 

Basically, the three functions "New", "Open" or "Edit" are available. 

The "New" function creates a new visualization. By clicking "Open", visualizations (templates) 

that have been defined earlier and stored are available. By clicking "Edit", templates that have 

been defined earlier can be changed (e.g. select additional channels, delete templates etc.). 

Clicking the corresponding icon opens a working window in the right half of the screen. This 

window takes you step-by-step through the process for displaying the stored data in the desired 

variant. 

Icons in the upper area help you navigate through the individual steps: Icons in the working 

window that are grayed out are not available for the corresponding work step. 

  Green arrow pointing left: Corresponds to the "Back" button; jump to the previous 

definition step. 

 Green arrow pointing right: Corresponds to the "Next" button; jump to the next 

definition step. 

 Question mark: Help; call up the help function for the corresponding definition step. 

NOTICE  
In the Essential version, templates can be created, displayed and edited only if they contain data 

from devices supported by this software version! Only one device can be assigned in each case to 

the templates! 
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3.1 Visualization of saved data  

3.1.1 Visualization  -> New  

3.1.1.1 Step 1 of 4: Select device  

In step 1, the source devices are selected. On the left side of the working window, you can see 

the Plant View (see 5.1 Data management -> Plant view). This view lists all devices for which 

you can visualize the data. 

NOTICE  
Only supported devices can be selected in the Essential version!  

No more than one device can be selected! 

The right side of the working window shows the summary of the selected devices: 

 

You can select a device for the visualization by checking the device in the Plant View and clicking 

or double-clicking the blue arrow that appears. 

If you later want to remove a device from the list of selected devices, select it in the right-hand 

list, then double-click the selected device or click the blue arrow that points towards the left to 

remove it from the list. 

If at least one device has been selected, the "Next" button appears. Click this button to jump to 

the next step. 

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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3.1.1.2 Step 2 of 4: Select channel  

In step 2, select the reports and channels: 

 

Functions: 

Trend:  

Measurement values: Instantaneous values (analog values) of the selected device can be selected. 

Reports:  

Reports can be selected for the selected device, e.g. day, week, month, external (selection only 

possible if these reports are stored in the device). 

Channels: 

Device designation/TAG, device type: This shows information about the selected device.  

Min, max, average, instantaneous: Selection of the analog values of the device. 

Status: Selection of the digital values of the device. 

 

After selecting the analyses and channels for the data to be visualized, you can jump to the next 

step using "Next". 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

You can return to the previous view by selecting "Back".  



3 Task pane -> Visualization 

41 

3.1.1.3 Step 3 of 4: Select time slot or batch 

In step 3, select the time slot (or the batch, if available) of the data to be visualized: 

 

After selecting at least one time slot for the data to be visualized, you can jump to the next step 

using "Next". 

NOTICE  
A maximum of 3 identical time ranges can be selected and thus compared with each other. 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

You can return to the previous view by selecting "Back".  
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3.1.1.4 Step 4 of 4: Graph 

Step 4 displays the Graph, Values and Events of the selected Time Slot: 

 

 

The following functions of the icons are 

possible:  

  Disk: Save the visualization; if it has not yet been saved, a new template is created. 

This template is then available for future visualizations. 

  Disk with pen: Save as; create a new template, assign a new name for the template. 

 Box with arrow: Export; enables you to export the selected data in the *.csv or *.xls 

formats. 

  Printer icon: Print; allows you to print the current window. 

  Adobe Acrobat® icon: Export as PDF file. 
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 Bar chart: Change chart settings: 

 

 Pin: Enable or disable value cursor. If you move the cursor over the chart, the value 

displayed below the graph is automatically updated according to the position of the cursor. 

By pressing the left mouse button, the displayed values in the "Values" and "Events" area are 

also updated. 

 Notepad: Add comment; enables you to add comments in the chart area, this option is 

available for the chart view exclusively. 

 Magnifying glass+: Zoom in 

 Magnifying glass-: Zoom out 

 Magnifying glass 1:1: Reset zoom 

  Gear with printer: Automatic print out 

  Gear with Excel: Automatic Excel/ CSV export 

  Gear with Adobe Acrobat® icon: Automatic PDF export 

  Rectangle with blue arrow: Maximize or minimize the chart 

NOTICE  
The "Automatic print out", "Automatic Excel/CSV export“ and "Automatic PDF export“ functions 

are not supported in the Essential version and therefore cannot be selected. 

"Graph" area: 

Double-clicking the header in the "Graph" area enlarges the graphic view and shows it in full-

screen mode. The function corresponds to the "Maximize the Chart" icon. This enables you to 

work more conveniently without additional scrolling effort: 
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The note "Reduced data volume" means that the data have been reduced automatically to 

compile the chart. This enables a fast display. If you zoom into the chart (multiple times), this 

note no longer appears, as all values must be used for the display.  
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You can left-click to draw a frame in the chart field. This enables you to enlarge the selected area: 

 

Left-clicking an entry in the legend (right) opens a window with additional chart settings: 
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"Values" area: 

Display all values with a time stamp. You can select "Search" to search for values for a specific 

day/time.  

If the cursor  is enabled, pressing the left mouse button updates the displayed values 

according to the position of the cursor in the diagram: 

 

"Program Logbook" area: 

When measured values of a sampler are selected, the program logbook is displayed in an 

additional area. It contains all the sample programs that have been fully completed in the selected 

time period. There is a "Document" button beside the 'Program logbook' header:  

 

Once a sample program has been selected, it can be opened with the "Document" button and 

then saved and printed out: 
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"Events" area: 

Events of the selected device are shown here.  

If the cursor  is enabled, pressing the left mouse button updates the displayed events 

according to the position of the cursor in the diagram: 

 

Select "Close" to end the visualization. The window closes. 

You can return to the previous view by selecting "Back".  

3.2 Visualization of current data (Live View)  

3.2.1 Visualization  -> New  

3.2.1.1 Step 1 of 4: Select device  

In step 1, the device to be visualized is selected: 

 

The selected device appears on the right-hand side. 

If you later want to remove a device from the list of selected devices, select it in the right-hand 

list, then double-click the selected device or click the blue arrow that points towards the left to 

remove it from the list. 

If a device has been selected, the "Next" button appears. Click this button to jump to the next 

step. 

Clicking "Cancel" terminates this action, closes the window and ends the process. 
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3.2.1.2 Step 2 of 4: Read channel information  

In step 2, the software reads out the channels of the connected device. Once the read process is 

completed, the device automatically skips to step 3. 

 

3.2.1.3 Step 3 of 4: Select channels and display format  

In step 3, select the channels and display format: 

 

NOTICE  
Up to 40 channels or 100 digital inputs can be selected. 

Select the channels to be selected and the display format. Measured value curves, bar graphs and 

digital values are available as possible display formats. 

If at least one channel has been selected, the "Next" button is enabled and it is possible to skip to 

the Live View. 
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3.2.1.4 Step 4 of 4: Display current values (Live View)  

Display current values as measured value curves 

 

Display current values as bar graphs 

 

Display current values as digital values 

 

In step 4, the current data for the selected channels/inputs are displayed.  

The following functions of the icons are possible: 
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 Back. Return to the previous step 

 Next. Skip to the next step. Only active if "Back" was pressed beforehand. 

 Disk: Save the visualization. Save the current visualization as a template. If a template has 

been opened and modified, the template is overwritten with the new settings. 

 Disk with pen: Save as. Create a new template, assign a new name for the template. 

 Adobe Acrobat® icon: Export as PDF file. Export current view as PDF (only for graph 

display). 

 Bar chart: Change the chart settings: 

 
Setting the update rate 

 
Settings for the individual channels: color, area 

 Reset line chart. Reset the measured value curve (only for measured value curve view). 

Pin: Enable or disable value cursor (only for measured value curve view). If you move the 

cursor over the chart, the value displayed below the graph is automatically updated according 

to the position of the cursor. By pressing the left mouse button, the displayed values in the 

"Values" and "Events" area are also updated. 
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 Rectangle with blue arrow: Maximize or minimize the chart 

 

By pressing the "Back" button you can call up and change the channel selection again. 

All the channels selected in step 3 are displayed in the right-hand section of the window. The 

channels can be displayed and hidden by checking and unchecking the check boxes. 

 

3.3 Visualization  -> Open 

3.3.1 Step 1 of 4: Select template 

In step 1, you can select the template of the data to be visualized: 

 

If a template has been selected, the "Next" button appears. If there is a template for saved data, 

you go directly to step 3. If there is a template for current data, measured value display 

commences immediately. 

NOTICE  
In the Essential version, templates can be selected and opened only if they contain data from 

devices supported by this software version! Templates with more than one device cannot be 

opened! 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

 

3.3.2  Step 2 of 4: Select channel 

Step 2 is skipped automatically as the reports and channels of the source devices are already 

stored in the selected template. 

 

3.3.3 Step 3 of 4: Select time slot or batch 

Only for the visualization of saved data. This step is skipped if there is a template for displaying 

current measured values. 

In step 3, select the time slot (or the batch, if available)  of the data to be visualized: 
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After selecting at least one time slot for the data to be visualized, you can jump to the next step 

using "Next". 

NOTICE  
A maximum of 3 identical time ranges can be selected and thus compared with each other. 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

You can return to the previous view by selecting "Back".  

 

3.3.4 Step 4 of 4: Graph 

Step 4 displays the graph, values and events of the selected time slot or live data (for descriptions, 

see Section 3.1.1.4 or 3.2.1.4).  
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3.4 Visualization -> Edit template 

3.4.1 Step 1 of 4: Select template  

You can edit stored templates here:  

 

By selecting a template and right-clicking, you can delete or rename the selected template. 

After selecting a template, you can jump to the next step using "Edit" and edit the template.  

NOTICE  
In the Essential version, templates can be selected and edited only if they contain data from 

devices supported by this software version! Templates with more than one device cannot be 

edited! 

Select "Close" to end the process. The window closes. 
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3.4.2 Step 2 of 4: Select devices  

In step 2, the source devices are selected. On the left side of the working window, you can see 

the Plant View (see 5.1 Data management -> Plant view). This view lists all devices for which 

you can visualize the data. 

The right side of the working window shows the devices saved in the visualization template: 

 

You can select a device for the visualization by checking the device in the Plant View and clicking 

or double-clicking the blue arrow that appears. 

If you later want to remove a device from the list, select it in the right-hand list, then double-click 

the selected device or click the blue arrow that points towards the left to remove it from the list. 

NOTICE  
Only supported devices can be selected in the Essential version!  

No more than one device can be selected! 

If at least one device has been selected, the "Next" button appears. Click this button to jump to 

the next step. 

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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3.4.3 Step 3 of 4: Select channels  

In step 3, select the reports and channels: 

 

Functions: 

Trend:  

Measurement values: Instantaneous values (analog values) of the selected device can be selected. 

Reports:  

Reports can be selected for the selected device, e.g. day, week, month, external (selection only 

possible if these reports are stored in the device). 

Channels: 

Device designation/TAG, device type: This shows information about the selected device.  

Min, max, average, instantaneous: Selection of the analog values of the device. 

Status: Selection of the digital values of the device. 

 

After selecting the reports and channels for the data to be visualized, the selected template is 

overwritten by selecting "Update". 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

You can return to the previous view by selecting "Back".  
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3.4.4 Step 4 of 4: Update template 

In step 4, you update the template selected in step 1. 

A progress bar shows the progress in % and displays the estimated time remaining.  

Once the action has been completed, a confirmation text appears below the progress bar: 

 

To modify additional templates, you can return to step 1 by selecting "step 1". 

Select "Close" to end the process. The window closes. 
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4. Task pane -> Reporting  

NOTICE  
The "Reporting" section is only available if the license was ordered with the Reporting 

functionality (optional). The reporting functionality is described in detail in Section 9.1 Reporting. 

5. Task pane -> Data management 

The task "Data Management" includes all functions that pertain to the management of data and 

devices.  

The data are managed by importing data (e.g. in non-secure format as *.csv or *.xls or in secure 

format as *.fdm). The data can also be relocated from the database to reduce the volume of the 

database. 

The device management takes place primarily via the Plant View, i.e. the tree structure in which 

all available devices are listed. 

5.1 Data management -> Plant view)  

You can open the Plant View via the "Data Management -->Plant View" task. 

Before you can create devices, an enterprise must be present (is already defined as a default 

setting). The entire enterprise can then be divided into Site, Area, Process Cell and Unit. 

This division results in a tree structure with multiple nodes. You can assign multiple devices to 

each node: 

 

NOTICE  Not all devices are supported in the Essential version. Only devices supported by 

this software version can be assigned to the nodes. 

The Main Toolbar of the Plant View gives you the following options: 

 

  "Plus": Add a new node, i.e. further subdivide the structure of the enterprise; the 

hierarchy is as follows: Enterprise, Site, Area, Process Cell and Unit. Devices can be assigned 

to these nodes. These device nodes can also be renamed, deleted or moved to other plant 

areas (other higher-level nodes). 
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 "X": Delete a selected node, a device or data from the database. When you delete device 

data, the time range can be selected:  

 

 
 

NOTICE  
When you delete a node, the corresponding allocated subnodes and the devices assigned to 

these nodes are deleted along with all of the data. 

 "Scissors": Cut out the selected node and copy it to the clipboard. You can then reinsert 

the node by pasting it at another location in the Plant View. 

 "Clipboard": Paste a node copied to the clipboard earlier 

 "Pad with pen": Rename the selected node 

 "Rings": Merge data (see Section 5.1.1) 

 "Box with arrow": Import an existing Plant View / device tree (e.g. from FieldCare) (see 

Section 1.9) 

  "Wrench": Open the Communication Settings of the selected device (see Section 7.1) 

 "Two arrows": Load the Plant View from the database; this function is needed in order 

to update the Plant View (e.g. after creating a new device during the first read-out process). 

The options listed above (creating, deleting, renaming nodes; merging data; etc.) are also available 

in the context menu that appears when you right-click.  

 

Creating a new device: 

The read-out process for a new device creates a new device node in the Plant View. The readout 

can take place via the interface or from the storage medium (see Section 2). The data are 

analyzed while they are read out. If the read-out device is already stored in the database (with 

serial number and device designation/TAG and the same device configuration) the data are 

automatically assigned to the corresponding device node and thus to the known device. If there 

are deviations of the read-out device in the serial number or device designation/TAG, a new 

device node is created automatically. If the serial number and device designation/TAG do not 

differ, but the configuration was changed between the last read-out process and the current read-

out process, a new configuration node is created for the data under the existing device node. The 

read-out data are then assigned to this new configuration node. 

 

Importing an existing Plant View/existing device tree: 

The Reporting Software allows you to apply an existing, saved device tree or an existing Plant 

View from another program. This functionality is provided in the "Data Management -> Plant 

View" task. 

Pressing the "Box with arrow"  icon opens the menu structure of the computer. Select the 

storage location and the corresponding CSV file of the Plant View. Then, the tree structure is read 

into the database and stored there. The same function is provided by selecting the enterprise, 

then right-clicking and selecting "Import Plant View". 

 

Device settings: 

Settings that are assigned directly to a corresponding device can be defined using the setting 

menu in the Plant View. 
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To do so, select the corresponding device, then open the settings window by clicking the 

"Wrench" icon  or by right-clicking "Change Settings" from the context menu. For a detailed 

description, see Section 7. 

 

5.1.1 Merging configurations  

Individual devices which have been read out are identified in the Reporting Software via the 

device designation/TAG and serial number. In addition, the configuration of the channels is 

evaluated. 

If the read-out data can be clearly assigned to a device (via the serial number and device 

designation/TAG) but the configuration of the read-out device data does not match the stored 

device configuration, a new configuration is created below the device node. 

This can happen, for example, if the configuration of the device has been changed (e.g. a channel 

has been switched off or the unit of a channel has been changed) or the device has been used as a 

portable measuring instrument at different measuring points with a different configuration. 

If you want to merge data despite a different configuration, to ensure a continuous database and 

thus a continuous analysis, you can do so using the "Merge Configurations" function. 

When merging, the measuring data are always assigned to the latest, most recent configuration. 

Select a configuration in the Plant View in the task "Data Management -> Plant View" 5.1. This 

selected configuration is then assigned the data of the other configurations, i.e. the selected 

configuration remains in place. Clicking the "Rings" icon  or the context menu that appears 

when you right-click "Merge Configurations" opens a new dialog window: 
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5.1.1.1 Step 1 of 2: Select configurations  

The left side displays the devices available in the database and their assigned configurations. 

By double-clicking a configuration, selecting the configuration and clicking the arrow that points 

to the right in the center of the two boxes or dragging and dropping using the mouse, you can 

move the configurations to be merged to the right side. 

All data of these configurations in the right-hand box are merged and assigned to the 

configuration selected in the Plant View and the corresponding device.  

 

NOTICE  
Once devices and device configurations are merged, this cannot be undone. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to step 2 and merges 

the configurations.  
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5.1.1.2 Step 2 of 2: Merge  

It is only possible to merge configurations if no data are lost as a result of the merge. Example: A 

device has 2 configurations. 2 channels were active in the older configuration while one channel 

was switched off in the more recent configuration. As a result of the merge, all the data are 

assigned to the latest (more recent) configuration. In this example, only one channel would now 

be active. It would not be possible to access the data of the second channel. For this reason, in 

our example it is not possible to merge the configurations. In such situations a message is 

displayed. 

Other situations can, however, occur in which the user can decide whether the configurations 

are to be merged or not. An example would be changing a unit of a channel or switching a 

channel from average to minimum. A message is displayed here, e.g.: 

 

Select the appropriate button to either merge the configurations or cancel the merge. 

A progress bar shows the progress in % and displays the estimated time remaining. You can stop 

the action during this procedure by pressing the "Cancel" button. You can return to the previous 

view by selecting "Back".  

Once the action has been completed, a confirmation text appears below the progress bar: 

 

Select "Close" to end the process. The window closes. 

 

5.1.2 Merge devices  

Individual devices which have been read out are identified in the Reporting Software via the 

device designation/TAG and serial number. 
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If devices do not match in these points, they are created as separate devices in the Plant View. 

For replacement devices/spare devices, you are prompted to merge the data despite the different 

serial numbers to ensure a continuous database and thus a continuous analysis. The "Merge 

Devices" function enables you to do this. 

You can select one of the devices to be merged in the Plant View in the task "Data Management -

> Plant View" 5.1. The selected device remains, and all data of the devices to be merged are 

assigned to this selected device from now on. Clicking the icon  or the context menu that 

appears when you right-click "Merge Devices" opens a new dialog window:  

5.1.2.1 Step 1 of 2: Select devices  

The left side stores the devices available in the database. 

By double-clicking a device, selecting the device and clicking the arrow that points to the right in 

the center of the two boxes or dragging and dropping using the mouse, you can move the devices 

to be merged to the right side. 

All data of these devices in the right-hand box are merged and assigned to the device selected in 

the Plant View:  

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to step 2 and merges 

the data of the devices.  
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5.1.2.2 Step 2 of 2: Result: merge devices   

A progress bar shows the progress in % and displays the estimated time remaining. You can stop 

the action during this procedure by pressing the "Cancel" button. You can return to the previous 

view by selecting "Back".  

After the devices and their data have been merged successfully, a confirmation text appears below 

the progress bar: 

 

NOTICE  
Once devices are merged, this cannot be undone. 

Select "Close" to end the process. The window closes. 

5.2 Data management -> Export 

You can export the data stored in the database. 

Various options exist for doing so: 

- Tamper-proof export in a secure format (binary files *.fdm) 

- Export to non-secure formats (Excel / CSV) 

Data that are exported in the secure format cannot be modified. This enables you to securely 

relocate the data to reduce the data volume in the database or to transfer data to another database 

or another user so that they are secured against tampering. 

If data in the secure format are read back into the Reporting Software, they are treated the same 

as original data. 

If data are stored in Excel or CSV format, they are identified as manual data. 

The differentiation of the type of export takes place in the first step by selecting the file 

type/format. 
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5.2.1 Export in a secure format (binary files, *.fdm)  

To export data, the export function under "Data Management –> Export" is used. The export in 

the secure format takes place in 6 steps: 

5.2.1.1 Step 1: Select export format  

You can choose between "binary files (*.fdm), Excel (*.xls)", "CSV files (*.csv)" or "CSV for 

energy monitoring files (*.csv)". 

To export in the secure format, select "binary files (*.fdm)" here: 

 

Note about export for energy monitoring: 

Data for energy monitoring are exported in a non-protected format (*.csv) with specially matched 

properties (column limit, date and time format are set by default). To import measured values of 

the evaluation software to the energy monitoring software, you have to enter an import code 

there. The import code is composed of <channel name>-<type>, i.e. the combination of the first 

two cells in each column.  

Example: "Analog 1-average" or "Analog 2-" 

NOTICE  A "CSV for energy monitoring files (*.csv)" export is not supported in the Essential 

version. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  
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5.2.1.2 Step 2 of 6: Select device  

The left side shows the devices available in the database. 

By double-clicking a device, selecting the device(s) and clicking the arrow that points to the right 

in the center of the two boxes or dragging and dropping using the mouse, you can move the 

device(s) to be exported to the right side. 

You can export the data of the device on the right side. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  

 

5.2.1.3 Step 3 of 6: Select time slot  

You can define a time range using the drop-down lists provided. All stored data of the selected 

devices that lie within this time range are exported. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  
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5.2.1.4 Step 4 of 6: Select file name and file size  

Output File: 

File name: You can define the storage location here. Clicking the "..." button opens the menu 

structure of the computer and the storage location for the export can be selected. 

Maximum file size: To limit the size of the export file or adapt it to the medium of the target 

storage location (such as DVD, CD), you can select the target medium using the drop-down list: 

 

Beneath that, two additional functions are offered: 

Repeat export periodically: 

Automatic export and automatic storage of data in secure format. Enabling/checking this check 

box activates an automatic function for export.  

Delete data after export was successful: 

Enabling this check box deletes the successfully exported data from the database. This means that 

the data are no longer available in the database, but only as a secure export file. 

NOTICE  
Once data are deleted from the database, this cannot be undone! If you want the data to be 

available later for reports or visualizations, these data exported in the secure format must be re-

imported into the Reporting Software. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  



5 Task pane -> Data management 

67 

5.2.1.5 Step 5 of 6: Configure automatic  

NOTICE  
This is visible only if "Repeat export periodically" has been selected in the previous step: 

 

Data backup: 

The interval for automatic export is defined here. For this purpose, the "Active" check box must 

be selected. 

Interval: How often does the export take place? 

Depending on the selected interval, define following points, such as repetition, Start day and Start 

time. 

Data time period: This selects the time range for export. This means that the export at the defined 

point in time contains the data of the selected time range, beginning at the start date/time of 

export and going back (see Section 7.6). 

File path: If a network drive is selected, you are also asked to enter a user and password. The 

setting is then saved and can be modified under "Extras -> Settings -> Automatic" (see Section 

6.1.6). 

NOTICE  
Logon for the automatic service must be modified to allow the automatic function access to the 

network drive (see Section 6.1.6). 

Data elimination: 

NOTICE  
Once data are deleted from the database, this cannot be undone! Ensure that data that are 

deleted from the database are really no longer needed, or have already been saved to another 

storage location as a secure export so that they are available later if needed. 

This configures the automatic function for deleting the data from the database. If you select the 

"Active" check box, exported data are deleted irretrievably from the database (see Section 7.4).  

NOTICE  
Before confirming with the "Next" button, please check the selection you have made: 

Do you really want to delete the data? Do the automatic export function and automatic deletion 

overlap? Have you ensured that the data are not deleted before the secure export? 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step, starts 

the export, deletes the data and starts the automatic function (if selected). 
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5.2.1.6 Step 6 of 6: Export data  

A progress bar shows the progress in % and displays the estimated time remaining. You can stop 

the action during this procedure by pressing the "Cancel" button. You can return to the previous 

view by selecting "Back".  

After the data are exported successfully, a confirmation appears below the progress bar: 

 

Select "Close" to end the process. The window closes. 
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5.2.2 Exporting in a non-secure format (Excel/CSV, energy monitoring)   

To export data, the export function under "Data Management –> Export" is used. The export to a 

non-secure format (Excel/CSV) takes place in 8 steps: 

 

5.2.2.1 Step 1 of 8: Select export format  

You can choose between "Excel (*.xls)", "CSV files (*.csv)" or "CSV for energy monitoring files 

(*.csv)": 

 

Note about export for energy monitoring: 

Data for energy monitoring are exported in a non-protected format (*.csv) with specially matched 

properties (column limit, date and time format are set by default). To import measured values of 

the evaluation software to the energy monitoring software, you have to enter an import code 

there. The import code is composed of <channel name>-<type>, i.e. the combination of the first 

two cells in each column.  

Example: "Analog 1-average" or "Analog 2-" 

NOTICE  A "CSV for energy monitoring files (*.csv)" export is not supported in the Essential 

version. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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5.2.2.2 Step 2 of 8: Select usage of template  

Here, you can select which data are exported: 

 

Don't use templates: 

If the following device and channel selection should apply for the export only, and if the report to 

be defined is not needed for other automatic actions (automatic visualization/automatic print 

out), you can select the "Don't Use Templates" option here. 

Create new template: 

If you want to define a new template, you can select the "Create New Template" option here. In 

this case, the template is also available for later visualizations. Templates are predefined reports 

with preselected devices and channels.  

Using the "Template Name" line, you can assign a new name for the template to be created. Only 

after a name is defined can you jump to the next step. 

You cannot use names that have already been assigned as in this case the existing template would 

be overwritten. If you want to change an existing name of a template to identify it uniquely, you 

can do so by right-clicking and selecting "Rename". 

Open Template:If a report to be generated has already been defined as a visualization and stored 

as a template, you can select the template (which already contains the corresponding devices and 

channels) here. 

NOTICE  In the Essential version, templates can be selected only if they contain data from 

devices supported by this software version! Templates containing more than one device cannot be 

edited! 

 

If you want to make changes in the device or channel selection, you can do so by clicking the 

"Back" button or the corresponding green arrow icon in the Main Toolbar. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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5.2.2.3 Step 3 of 8: Select devices  

NOTICE  
This step is skipped if you are using an existing template. 

The left side displays the devices available in the database and their configurations. 

By double-clicking a configuration, selecting the configuration and clicking the arrow that points 

to the right in the center of the two boxes or dragging and dropping using the mouse, you can 

move the devices to be exported to the right side. 

You can export the data of the devices on the right side. 

 

NOTICE  
Only supported devices can be selected in the Essential version!  

No more than one device can be selected! 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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5.2.2.4 Step 4 of 8: Select channels  

NOTICE  
This step is skipped if you are using an existing template. 

The left side displays the active channels of the selected devices/configurations. You can select 

the corresponding channels by selecting the check boxes. 

You can select all active channels by selecting the check box of the configuration (of the 

respective higher-level check box). 

 

Functions: 

Trend:  

Measurement values: Instantaneous values (analog values) of the selected device can be selected. 

Reports:  

Reports can be selected for the selected device, e.g. day, week, month, external, measuring 

periods (selection only possible if these reports are stored in the device). 

Channels: 

Device designation/TAG, device type: This shows information about the selected device.  

Min, max, average, instantaneous: Selection of the analog values of the device. 

Status: Selection of the digital values of the device. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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5.2.2.5 Step 5 of 8: Select time slots or batches  

You can define a time range (or the batches if available) using the drop-down lists provided. All 

stored data of the selected devices that lie within this time range are exported.  

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 

 

5.2.2.6 Step 6 of 8: Select file name  

You can define a storage location in the "Output File" box. Clicking the "..." button opens the 

menu structure of the computer and the storage location for the export can be selected. 

Data: Select whether only values and/or events should be exported. 
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Repeat export periodically: Automatic export and automatic storage of data in non-secure format. 

Enabling/checking this check box activates an automatic function for export.  

NOTICE  Automatic export and automatic storage of data in a non-secure format are not 

supported in the Essential version. 

NOTICE  
"Repeat export periodically" is possible only when using a template. (See step 2 of 8). 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 

 

5.2.2.7 Step 7 of 8: Configure automatic  

NOTICE  
This is visible only if "Repeat export periodically" has been selected in the previous step. 

In the "Excel/CSV Export" box, you can define the interval (repetition rate) of the automatic 

export. For this purpose, the "Active" check box must be selected. 

Interval: How often does the export take place? 

Depending on the selected interval, define the following points, such as repetition, start day and 

start time (see Section 7.6). 

Data time period: This selects the time range for export. This means that the export at the defined 

point in time contains the data of the selected time range, beginning at the start date/time of 

export and going back. 

Export type: Select whether only values and/or events should be exported. 

File handling: Select whether a new export file should be created, whether the export file should 

be appended to an existing file or whether the existing file should be overwritten. 

File size: In order to restrict the size of the export file or to adjust it to the medium of the storage 

location (such as DVD, CD) the target medium can be selected in the drop-down list. 

File path: If a network drive is selected, you are also asked to enter a user and password. The 

setting is then saved and can be modified under "Extras -> Settings -> Automatic" (see Section 

6.1.6).  

NOTICE  
Logon for the automatic service must be modified to allow the automatic function access to the 

network drive (see Section 6.1.6). 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step and 

starts the export and the automatic function (if selected). 
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5.2.2.8 Step 8 of 8: Export data  

A progress bar shows the progress in % and displays the estimated time remaining. You can stop 

the action during this procedure by pressing the "Cancel" button. You can return to the previous 

view by selecting "Back".  

After the data are exported successfully, a confirmation appears below the progress bar: 

 

Select "Close" to end the process. The window closes. 
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5.3 Data management -> Import  

The Reporting Software allows you to import data into the database. 

These data can be provided by devices as well as files. 

For this purpose, you have the option of importing data that were previously exported in the 

secure format using the *.fdm format. This format ensures that data are tamper-protected and 

thus are genuine measured data. 

It is possible to import data from the ReadWin 2000 PC software via the rsd format (see Section 

1.10). 

NOTICE  The transfer of data from ReadWin 2000 is not supported in the Essential version! 

It is also possible to import data from Excel (*.xls) or as a CSV file (*.csv). This can be used for 

planning data, for example. This enables you to carry out direct comparisons of planning data and 

actual measured data. 

Data imported in XLS or CSV format are identified as manual data. 

 

Import format for Excel (*.xls) or CSV (*.csv) files: 

If data are to be imported into the Reporting Software using Excel or CSV, the values (measured 

values, channel names etc.) must be entered into the corresponding file. It is important that the 

time stamp cell has the format (e.g. YYYY-MM-dd hh:mm:ss). 

ISO 8601 must be taken into consideration for the format of the time stamp cell. The dash "-" is 

defined as the separator for the day, month and year.  

Example: 

 

Time format  
(YYYY-MM-dd hh:mm:ss) 

Channel 1 
name 

Channel 2 
name 

Channel 3 
name 

Channel 4 
name … 

 
Channel 1 
unit 

Channel 2 
unit 

Channel 3 
unit 

Channel 4 
unit … 

2000-11-23 23:48:34 0.0002 0.01 12 2778  

2000-11-23 23:48:35 0.345 0.03 24 56456  

2000-11-23 23:48:36 0.0688 0.05 36 110134  

2000-11-23 23:48:37 0.1031 0.07 48 163812  

2000-11-23 23:48:38 0.1374 0.09 60 217490  

2000-11-23 23:48:39 0.1717 0.11 72 271168  

 



5 Task pane -> Data management 

77 

5.3.1 Step 1 of 3: Select source  

You can define a storage location for the data in the "Select File" box. Clicking the "..." button 

opens the menu structure of the computer and you can select the file to be imported. 

If you select a file in the secure format (*.fdm), step 2 is skipped, as the devices to be imported 

have already been defined by the format. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 

 

5.3.2 Step 2 of 3: Select device  

Select a device or a node in the Plant View. The data to be imported are then assigned 

organizationally to this plant section: 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step and 

starts the import. 
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5.3.3 Step 3 of 3: Import data  

A progress bar shows the progress in % and displays the estimated time remaining. You can stop 

the action during this procedure by pressing the "Cancel" button. You can return to the previous 

view by selecting "Back".  

After the data are imported successfully, a confirmation appears below the progress bar: 

 

Select "Close" to end the process. The window closes. 
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5.4 Data management -> Automatic  

The automatic function is set up as a system service and runs in the background. Before you can 

activate an automatic function, you have to install the automatic component during the initial 

installation of the Reporting Software. If the automatic component is installed, the 

 icon appears on the bottom right of the window. If this icon is not 

present, the component has to be installed. This is available on the installation DVD (see Chapter 

1.5). 

NOTICE  Only automatic readout, automation deletion of data in the device following 

successful readout and automatic binary export are supported in the Essential version. The 

"Automatic XLS/CSV export", "Automatic PDF export" and "Automatic print out" functions are 

not available in this software version. 

 

5.4.1 Automatic information: Current overview  

All the automatic functions are set up in the "Data Management –> Automatic" task. In addition, 

the task also provides an overview of all the active or inactive automatic processes. 

NOTICE  
The automatic functions defined in the individual steps are still valid and can also be managed via 

the central task described here. 

 

5.4.1.1 Step 1 of 3: Job type selection  

 

Automatic information: Select the desired information.  

Options: Current overview, Event view, Automatic new/edit. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 

 

5.4.1.2 Step 2 of 3: Select template or device  

Step 2 is skipped automatically as it is not necessary to make a selection for the automatic 

overview. 

5.4.1.3 Step 3 of 3: Automatic overview  

An overview of all the automatic tasks is provided in step 3: 
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The individual automatic task can be enabled or disabled here. 

Color code: 

Orange: Automatic task is disabled 

White: Automatic task is enabled and ready for execution 

Green: Automatic task is currently being executed 

Blue: Automatic task is selected and can be deleted by clicking "X" in the toolbar. 

Red: Status of the automatic service is unknown (error, e.g. automatic function uninstalled) 

Select "Close" to end the process. The window closes. 
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5.4.2 Automatic information: Event view  

All the automatic functions are set up in the "Data Management –> Automatic" task. In addition, 

the task also provides an overview of all the active or inactive automatic processes. 

NOTICE  
The automatic functions defined in the individual steps are still valid and can also be managed via 

the central task described here. 

 

5.4.2.1 Step 1 of 3: Job type selection  

 

Automatic information: Select the desired information.  

Options: Current view, Event view, Automatic new/edit. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 

 

5.4.2.2 Step 2 of 3: Select template or device  

Step 2 is skipped automatically as it is not necessary to make a selection for the event overview. 
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5.4.2.3 Step 3 of 3: Automatic event overview  

An event overview of all the automatic tasks is provided in step 3: 

 

Select "Close" to end the process. The window closes. 

 

5.4.3 Automatic new/edit  

All the automatic functions are set up in the "Data Management –> Automatic" task.  

NOTICE  
The automatic functions defined in the individual steps are still valid and can also be managed via 

the central task described here. 

 

5.4.3.1 Step 1 of 3: Job type selection  

 

Automatic information: Select the desired information.  

Options: Current overview, Event view, Automatic new/edit. 
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Select task (only possible for "Automatic new/edit"): 

- Read out device: The data stored in the field devices are automatically saved to the database. 

- Binary export: Is used for secure data export from the database, e.g. to relieve the SQL 

server. 

- Time synchronize: For regular, automated time synchronization, i.e. the time of the device is 

synchronized with the system time. 

- Delete data: Makes it possible to automatically delete data from the database. 

NOTICE  
Once data are deleted from the database, this cannot be undone!  

- Print out template: Makes it possible to automatically print out a visualization template at 

regular intervals, i.e. a report/visualization that has been defined is saved as a template and is 

regularly regenerated automatically and printed out.  

- XLS/CSV export: Makes it possible to automatically export data in XLS or CSV format at 

regular intervals. A template must also be selected here, i.e. a report that has been defined is 

saved as a template and is regularly regenerated automatically and exported.  

- PDF export: Makes it possible to automatically export data in PDF format at regular intervals. 

A template must also be selected here, i.e. a report that has been defined is saved as a 

template and is regularly regenerated automatically and exported.  

- Web export: Makes it possible to automatically export data to other systems via 

Endress+Hauser middleware. A template must also be selected here, i.e. a report that has 

been defined is saved as a template and the data are automatically sent to the middleware at 

regular intervals. 

NOTICE  
Only automatic readout, automation deletion of data in the device following successful readout 

and automatic binary export are supported in the Essential version. The "Automatic XLS/CSV 

export", "Automatic PDF export" and "Automatic print out" functions are not available in this 

software version. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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5.4.3.2 Step 2 of 3: Select template or device  

NOTICE  
Only possible if "Automatic new/edit" is selected in step 1. 

In step 2, the appropriate template or the device to be read out must be selected: 

 

 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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5.4.3.3 Step 3 of 3: Settings automatic  

NOTICE  
Only possible if "Automatic new/edit" is selected in step 1. 

The frequency is defined in step 3. For this purpose, the "Active" check box must be selected: 

 

You can then define the frequency using the interval, and define the start time (see Section 7.6). 

A data time period also has to be defined for the automatic tasks "Delete Data," "Create PDF", 

"CSV Export", "XLS Export" and "Binary Export" (secure format). 

File handling (for Excel/CSV export): Select whether a new export file should be created, 

whether the export file should be appended to an existing file or whether the existing file should 

be overwritten. 

File size (for Excel/CSV export): In order to restrict the size of the export file or to adjust it to the 

medium of the storage location (such as DVD, CD) the target medium can be selected in the 

drop-down list. 

File path: The location of the data report to be exported must be defined for all export automatic 

tasks. Clicking the "..." button opens the Explorer tree.  

If a network drive is selected, you are also asked to enter a user and password. The setting is then 

saved and can be modified under "Extras -> Settings -> Automatic" (see Section 6.1.6). 

NOTICE  
Logon for the automatic service must be modified to allow the automatic function access to the 

network drive (see Section 6.1.6). 

Timeout (s) (for Web export): Timeout for the transmission of data to the middleware 

User name / password (for Web export): User that is configured in the middleware. 

Web URL (for Web export): Web address of the middleware 

Certificate (for Web export): If communication with the middleware is to take place via https 

(encrypted connection), the corresponding certificate must be available permanently for the 

automatic service. 

Connection test (for Web export): To test the connection to the middleware. 

Clicking "Save" enables, saves and completes the configuration. 

Select "Close" to end the process. The window closes. 
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5.4.4 Automatic service  

The automatic symbol  for the system service is displayed in the 

bottom, right-hand corner of the Reporting Software. The system service can have different states: 

pending, paused, stopped, not installed, inactive, undefined status or active.  

Explanation of the various states: 

- "Pending": The service is currently locked and is waiting to be enabled. If this state does not 

change within 2 minutes, please notify your system administrator and restart the system 

service. 

- "Stopped", "Paused", "Ended": The service is not currently running. This can happen if the 

system administrator interrupts the service. 

- "Not Installed": The Reporting Software can also be installed without automatic 

service/automatic components. All automatic settings are inactive in this case. If you would 

like to subsequently install the automatic component, do so via the setup routine (like when 

installing for the first time). The "Install Automatic Component" option must be selected 

(ticked) in the setup routine (see Section 1.5).  

- "Inactive": The user can activate or deactivate the internal state of the defined automatic jobs 

in the Tray Icon menu (see Section 5.4.6). 

- "Active": The Windows system service/automatic function is active and running. 

- "Undefined Status": This state can appear if the database connection is not available, 

interrupted or if the service is in an undefined state. Please close the Reporting Software and 

all the automatic components and restart them. If the status still does not change, please notify 

your system administrator. 

Once an automatic service is started it remains active until is stopped manually, for example via 

the Tray Icon (see Section 5.4.6). 

 

5.4.5 E-mail notification    

If an error occurs when executing an automatic function (e.g. "Data readout"), the analysis 

software automatically sends a one-off e-mail notification to all configured recipients.  

The text-based e-mail contains in the subject line the general information "Automatic function 

failed". The body of the e-mail contains a meaningful error message with cause and corrective 

measures. 

This is noted in the log file, regardless of whether the e-mail is sent correctly or not. 

The analysis software does not verify if the e-mail was delivered correctly. This can be done only 

by the higher-level mail system. 

A description of how to configure e-mail notification can be found in section Fehler! 

Verweisquelle konnte nicht gefunden werden..  
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5.4.6 Tray Icon   

The ‘Tray Icon Application’ is started automatically during system startup. Once the application 

has started, the tray icon appears in the Windows menu program.  

Right-clicking the icon opens a local menu: 

 

The tray icon changes to as soon as an automatic action is busy. The default icon is 

displayed when the automatic service is active but not currently executing an action. 

 

Reporting Software: 

The first entry has a subitem to open and close the Reporting Software: 

 

Automatic: 

 

 

The Automatic function can be activated or deactivated in the next entry. Activation is only 

possible if the Windows service is started under "Extras -> Settings -> Automatic" (see Section 

6.1.6).  

All the defined automatic functions appear in the Automatic subitem. Individual tasks can be 

manually set to active or inactive. If a task is set to inactive, it is not executed at the time of the 

next service.  

Each time you click the Tray Icon Application, the view of the defined tasks is synchronized with 

the Reporting Software and the display is refreshed.  

Log file: 

The entry opens the documentation file (WindowsServiceLog.txt), which documents all the 

activities of the system service. The documentation file is saved under: 

Windows 2000 / XP: “C:\Documents and settings\All Users\Application data\ 
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Endress+Hauser\ FieldDataManager” 

Windows VISTA and higher: “C:\ProgramData\Endress+Hauser\FieldDataManager” 

Log off: 

When user administration is active, the user is also requested to log on for the Tray Icon 

application. Only then is the functionality available. Once the user has logged on, no further 

check is carried out unless the user logs off again using the "Log off" function. Logging on for the 

Tray Icon is independent of logging on for the Reporting Software. 

Exit: 

"Exit" closes the Tray Icon window. This does not affect the system service, however. 

If the Tray Icon should not be started automatically, this can be disabled in the Reporting 

Software under "Extras -> Settings -> Automatic" (see Section 6.1.6). If user administration is 

enabled in the Reporting Software, the user code must be entered beforehand. 
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6. Extras menu 

6.1 Extras -> Settings  

Here, you can configure general settings for the database, language, export format and user 

administration. 

6.1.1 Language   

You can select the languages available in the Reporting Software via the drop-down menu. 

If you change the language setting, the change does not take effect until after the software is 

restarted. 
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6.1.2 Database  

In the database settings allow you to select the database used or the corresponding SQL server.  

You can configure detailed, user-defined settings using the box in the bottom section of the dialog 

window. To do so, you can assign the server name and port number for existing databases and 

configure a timeout for automatic disconnection. 

If a certain username and password are required for an existing SQL server database, this 

information can also be entered here. 

 

NOTICE  
Only the PostgreSQL™ database is supported in the Essential version!  

When using the Essential version, a database stored in the network cannot be accessed 

simultaneously by multiple PCs. 

 

6.1.3 Export 

Configure the export formats. For descriptions, refer to Section 5.2 "Data Management -> 

Export": 
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6.1.4 User administration   

Activate the security system via the user administration if you want to protect the unit against 

unauthorized operation. After the initial installation of the Reporting Software, the user 

administration function is disabled by default. 

Basic user administration settings are available in the "Extras –> Settings –> User Administration" 

menu: 

 

The user administration can be enabled in the settings. If enabled, the first user is automatically 

assigned the role of administrator. 

In addition to enabling the User Administration, you can define the corresponding requirements 

are defined that must be fulfilled by the passwords. 

To comply with the more stringent documentation and security requirements of FDA21 CFR Part 

11, this function must also be enabled. 

As a result of this function, the user has to identify himself or herself with a user ID and password 

whenever carrying out an action that affects the database (such as creating templates, creating or 

changing devices/device settings, deleting devices, etc.). 

Use of the reporting functionality is not possible if security requirements in accordance with 

FDA21 CFR Part 11 are enabled. 

The administration of users takes place in the function "Extras –> User Administration" (see 

Section 6.3). 

NOTICE  
User administration can be enabled only in the Professional and Demo versions! 
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6.1.5 Printer  

The printout format is defined in the "Printer" menu. If a logo is to appear on the printout, this 

can be selected and defined via the "Change Logo" button. 

You can define the font using the drop-down list: 

 

 

The following menu opens if the printer icon  is clicked in the Reporting Software, e.g. in 

visualization: 

 

The required printer, the print layout and settings can be selected here. A print preview is also 

possible. 

  

In the visualization printer settings, you can select if the print-out is to be line-based or column-

based. The column-based layout is enabled as standard. The line-based layout is enabled only for 

templates which contain analyses. 
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6.1.6 Automatic  

NOTICE  
If user administration is enabled, an administrator must be logged on before these automatic task 

settings can be changed. 

6.1.6.1 Windows System Service  

The "Automatic" menu contains start and stop functions for Windows System Service and for the 

Tray Icon Application. In addition, you can also define whether these functions should be started 

automatically here:  

 

 

Network login identity: 

The automatic function requires a user and a password in order to log onto a remote computer 

and get access to a directory. This user must have the appropriate rights for the selected directory. 

NOTICE  
Logon for the automatic service must be modified to allow the automatic function access to the 

network drive: 

1. Open 'Endress+Hauser FDM Service': "Control Panel -> System and Security -> 

Administration -> Services -> double-click "Endress+Hauser FDM Service": 
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2. Switch to "Log on". Create a user with appropriate rights under "This account": 

 

Click "Apply" and "OK" to save the settings. 

3. The service must be restarted in order to activate the new setting: 

 

 

Data server settings: 

Configuration of data server connection for the online data of devices set up in the analysis 

software. The host name is identical to the computer on which the automatic service is running. 

Port: The port is preconfigured to "8007". Any change is automatically adopted by the data 

server. 
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6.1.6.2 E-mail configuration 

The mail function can be activated or deactivated, as required. The function is deactivated as 

standard. To enable e-mails to be sent correctly, the following settings are required: 

Recipient:  

Up to 10 recipient addresses can be entered. Individual e-mail addresses are separated by a 

semicolon (;). 

SMTP Server / Port: 

Enter the SMTP server and port used.  

Sender: 

Name or e-mail address for sending mail (sender of notification mail). 

Authentication: 

For authentication, you can choose between "automatic detection", "no authentication", "PLAIN 

authentication" and "LOGIN authentication".  If an authentication mechanism is selected, the 

user must enter a user name and password. 

NOTICE  
For queries regarding sender settings, contact your network administrator or e-mail provider if 

necessary.  

To verify and activate the mail function, you must first send a test mail by activating the "Send 

test e-mail" button.  

The test mail must be sent successfully before the entries can be accepted with "OK". 

 

6.1.7 General  

In the General menu items, readout with extended service function can be enabled. If this is 

enabled, a field appears in the readout menu with the option not to delete data from the device 

once the data have been read out successfully. 

 

 

 

 

 

6.1.8 License server settings  

The license server is an independent program that is installed locally with the software and used 

locally.  
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By activating it, it is possible to make this local license server available as a central license server 

to additional software installations on other network computers: 

 

The use of a central license server is enabled by specifying the IP address or host name of the 

computer where the license server is installed. In addition, it is necessary to configure the port 

used (TCP: 22350): 

 

If you have queries relating to these fields, please contact your IT support department. The data 

are saved permanently. 
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6.2 Extras –> Audit trail 

For complete documentation, the audit trail function offers the display of all actions carried out by 

the Reporting Software and on the corresponding database. 

Any action that has an effect on the database is documented in the audit trail with the time stamp 

and user name (when User administration is enabled). This includes, for example, the following 

functions: create a new device, read out data, create template, user logs in, user logs out, report is 

generated, etc. 

In the Audit Trail, you can search for certain entries using the filter (Time, Text, User, Category). 

You can print out the Audit Trail using the printer icon .  

The  icon allows you to export the audit trail as a PDF file. 
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6.3 Extras -> User administration   

NOTICE  
User administration can be enabled only in the Professional and Demo versions! 

The administration of users takes place in the function "Extras –> User Administration". This 

menu item can be accessed by administrators only. The administrator can create up to 50 users. 

Once a user is created, he or she appears in the overview in the left box: 

 

Create a user: 

You can add new users using the "Person with plus sign" icon . 

User ID: For each user, the administrator has to assign a unique User ID. Max. 8 characters 

Password, password confirmation: For the initial login of the user, the administrator has to assign 

a password. Max. 10 characters  

Selecting the "Password Must be Changed after First Login" function ensures that the new user 

has to change the first password he or she is assigned: 

 

When logging in for the first time, the user must enter the password assigned by the 

administrator at the first login and assign a new password. 

 

Access role: You can assign various access roles to the user. These define the scope of user and 

access rights. 

The following overview defines the rights for the individual user roles: 

 

Access roles and access 

rights   

Adminis Service Planning Maintenan

ce 

System Observer 
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Responsibility trator Engineer Engineer Engineer Operator 

Create new site  X  X    

Create new area, unit X  X    

Create new devices  X  X X X  

Move sites and devices X  X    

Rename devices X  X X   

Site import from FieldCare 

CSV 

X  X    

Data readout X  X X X  

Data export X  X X   

Data import X  X X   

Import tamper-proof data X  X X X  

Export tamper-proof data X  X X   

Visualization, printout, PDF, 

CSV 

X  X X X X 

Create, modify, delete 

automatic functions 

X  X X   

Start/stop automatic X  X X X  

Select, merge data X  X X   

Delete data X  X X   

Change language X  X X X X 

Change export settings X  X X   

Password settings X      

User administration X      

Audit trail view  X X     

 

NOTICE  

The user rules for reporting are explained in Section 9.1.1 User roles.
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Edit user: 

Using the "Person with pen" icon you can modify the information about the user and reset 

the password. The dialog for changing the user information corresponds to the settings for 

creating a new user: 

 

The "Deactivate user" function enables you to block a user temporarily. In this case, a lock icon 

for "Locked" appears in the user overview. 

If the user enters incorrect information multiple times when logging in, the user also shows up as 

locked. The administrator can remove the lock by resetting the password. The user can then 

change the password again. 

Delete user: 

The "Person with red X" icon  allows you to delete a user selected in the list. Before the user 

is deleted, you are prompted for additional confirmation in a dialog window. If you confirm the 

deletion of the user, the corresponding account is deleted immediately. 

 

User rights for plant sections: 

In addition to the assignment of the user role, you can limit access to additional devices or plant 

sections. The assignment of the user rights for devices and plant sections takes place in the 

overview in the right-hand box: 

 

By selecting the user in the list, you can give this user defined access to individual devices and 

plant sections. In doing so, the administrator selects a node. This gives the user access to the 

corresponding node (e.g. site, area etc.) and to all assigned subnodes. 

If a user does not obtain access to certain plant sections or devices (node is not selected), these 

plant sections or devices are also not visible to the corresponding user in the Plant View. 
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Access rights to templates: 

The access rights to the templates are defined via the corresponding devices. A user has access to 

a template only if he or she has access to the corresponding devices. 

Access rights to devices: 

Access rights to devices are defined in the user administration function via the Plant View. If a 

user is the first to create and read out a device, the user who carries out the readout 

automatically obtains access rights to this device. 

Login as user: 

The user logs in with his or her user ID and password. These are case-sensitive. When logging in 

for the first time, the user must enter the password assigned by the administrator at the first login 

and assign a new password where applicable. Every logon, whether successful or not, generates 

an entry in the audit trail of the Reporting Software. 

Logout as user: 

The user can log out in different ways: 

- By closing the Reporting Software 

- By selecting "File -> Logout" 

- By selecting "File -> Login under another user name..." 

Every logout, whether successful or not, generates an entry in the Audit Trail of the software. 

 



7 Device Settings dialog 

102 

7. Device Settings dialog 

Settings that are assigned directly to a device can be defined using the setting menu. To do so, in 

the task pane select the corresponding device under "Data Management -> Plant View", then 

open the settings window by clicking the "Wrench" icon  or by selecting "Change Settings ..." 

from the context menu that appears when you right-click: 
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7.1 Communication Settings  

The Communication Settings of the devices are defined during the first read-out process. You can 

change already defined Communication Settings in the setting menu. 

The setting of the communication depends on the selected communication type and thus on the 

field device connected. 

In the first step, select the type of communication with the field device in the top area, "Select 

Source". The device type is defined by default through the selection of the device in the Plant 

View. 

After selecting the communication type, define the communication parameters in the lower area. 

To confirm and save the Communication Settings, you have to exit the menu using the "OK" 

button. 

 

Communication types and Communication Settings: 

Serial communication: For serial communication (RS232/485, etc.), configure the specified 

parameters.  

"Automatic": All available serial interfaces are scanned, thus providing automatic detection of the 

connected device and the necessary communication settings. 

"Manual": Define the communication parameters manually and enter them into the specified 

fields. 
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Modem: Enter the communication parameters in the specified fields. In some cases, these are 

provided in the documentation of the modem and from the wireless provider. 

 

 

Ethernet: Enter the Ethernet communication parameters manually in the specified fields. For 

detailed information such as the port number, contact your system administrator. 
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USB: You can usually keep the default USB setting. If necessary, change the "Device Address" and 

"Readout ID" parameters manually. 

 

 

7.2 Database information  

The database information in the device dialog provides information about the device data and the 

volume of data that has been read out of the device and imported into the database: 

 

Name: Name of the device  

Firmware version: Firmware version of the device 

Order code: Identifies the device with the ordered and delivered options  

Order identifier: Number identifying the device, order and customer 

Database size: Size of the device data that are stored in the SQL database. 

Additional device information can be accessed via the Endress+Hauser W@M portal using the 

order code and the order ID. This is relevant for device management over the entire life cycle of 

the plant. 
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7.3 Automatic – Read out device   

The automatic function for reading out the device is enabled/disabled in the Settings menu: 

 

(For more details, see Section 5.4 "Data Management –> Automatic") 

 

Active: Enables or disables the "Data Readout“ automatic function. 

Interval: Select the interval for this automatic function.  

Options: Minutely, hourly, daily, weekly, monthly 

Repeat every (only if minutely or hourly is selected for the interval): Select the time lag for the 

automatic function of the selected interval.  

Start day (only if weekly or monthly is selected for the interval): Select the day of the week for 

the automatic function of the selected interval. 

Start time (only if daily, weekly or monthly is selected for the interval): Select the starting time for 

the automatic function of the selected interval. 

Additional batch triggered:  

Can only be selected for the following automatic functions: Read out device, Print out template, 

XLX/CSV export and PDF export, if batch data are available. 

As soon as the batch job is completed, the automatic function is run. 
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7.4 Automatic – Delete data  

NOTICE  
Once data are deleted, this cannot be undone! Ensure that data that are deleted from the device 

are really no longer needed, or have already been saved to another storage location as a secure 

export so that they are available later if needed. 

The automatic function for deleting data is enabled/disabled in the Settings menu: 

 

Active: Enables or disables the "Data Elimination" automatic function. 

Interval: Select the interval for this automatic function.  

Options: Minutely, hourly, daily, weekly, monthly 

Repeat every (only if minutely or hourly is selected for the interval): Select the time lag for the 

automatic function of the selected interval.  

Start day (only if weekly or monthly is selected for the interval): Select the day of the week for 

the automatic function of the selected interval. 

Start time (only if daily, weekly or monthly is selected for the interval): Select the starting time for 

the automatic function of the selected interval. 

Time slot: Select the time slot for deleting the data. The data of the set time are not deleted.  

Example:  

Interval: Daily; start time: 23:59:00; time slot: 0 day 00:09:00 

The data are deleted daily at 23:59. The data of the last 9 minutes are retained in the memory. 
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7.5 Automatic – Time synchronize  

Here, you can automatically synchronize the device time with the system time of the computer. 

The automatic function for time synchronization is enabled/disabled in the Settings menu: 

 

Active: Enables or disables the "Time Synchronize" automatic function. 

Interval: Select the interval for this automatic function. 

NOTICE  
The possible options for the interval depend on the device. 

Repeat every (only if minutely or hourly is selected for the interval): Select the time lag for the 

automatic function of the selected interval.  

Start day (only if weekly or monthly is selected for the interval): Select the day of the week for 

the automatic function of the selected interval. 

Start time (only if daily, weekly or monthly is selected for the interval): Select the starting time for 

the automatic function of the selected interval. 

Tolerance: Select the tolerance for time synchronization. If the system time between the device 

and computer differs by more than the tolerance set here the time is not synchronized.  
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7.6 Automatic – Binary export  

The automatic function for data backup is enabled/disabled in the Settings menu: 

 

Active: Enables or disables the "Data Backup" automatic function. 

Interval: Select the interval for this automatic function.  

Options: Minutely, hourly, daily, weekly, monthly 

Repeat every (only if minutely or hourly is selected for the interval): Select the time lag for the 

automatic function of the selected interval.  

Start day (only if weekly or monthly is selected for the interval): Select the day of the week for 

the automatic function of the selected interval. 

Start time (only if daily, weekly or monthly is selected for the interval): Select the starting time for 

the automatic function of the selected interval. 

Data time period: Select the time period of the data to be backed up  

(e.g.: "0 day 10:00:00" saves the data of the last 10 hours).  

File path: The file storage location is defined here. Clicking the "..." button opens the menu 

structure of the computer and you can select the storage location. 

If a network drive is selected, you are also asked to enter a user and password. The setting is then 

saved and can be modified under "Extras -> Settings -> Automatic" (see Section 6.1.6). 

 

NOTICE  
A new file is created each time a backup copy of the data is created. The time stamp with the 

format "year-month-day h-m-s" is automatically added to the file name  

(e.g.: automatic_test_ 2010-06-25 08-09-30.fdm). 
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8. Troubleshooting 

8.1 System error messages 

Error messages during data readout: 

 

Error code Problem, cause Remedy 

0x200000
01 

An internal error occurred during data readout. Please try again. 

0x200000
02 

Unable to access the file. Please check the file path. 

0x200000
03 

Unable to access the data. Please check your access authorization. 

0x200000
04 

An error occurred when connecting to the device.  Please try again. 

0x200000
05 

An error occurred when communicating with the 
device. 

Please try again. 

0x200000
06 

The communication settings are not correct.  Please check the settings. 

0x200000
07 

An error occurred when communicating with the 
device.  

Please try again. 

0x200000
08 

An error occurred when communicating with the 
device.  

Please try again. 

0x200000
09 

An error occurred when communicating with the 
device.  

Please try again. 

0x200000
0A 

The Reporting Software does not support the 
connected device. 

Please select another device. 

0x200000
0B 

An error occurred when communicating with the 
device.  

Please try again. 

0x200000
0C 

The configured device address is not correct.  Please check the configuration. 

0x200000
0D 

The connection to the device has been 
interrupted.  

Please try again. 

0x200000
0E 

No device found at the interface.  Please check the connection and interface 
settings. 

0x200000
0F 

An error occurred when communicating with the 
device.  

Please try again. 

0x200000
10 

The IP address or host indicated cannot be found.  Please check the settings. 

0x200000
11 

The COM port indicated is being used by another 
application. 

Please check the connection settings. 

0x200000
12 

The COM port does not exist. Please check the connection settings. 

0x200000
13 

The data are corrupted and cannot be read in. Please notify Support. 

0x200000
14 

Unable to find the indicated path. Please check the file path. 

0x200000
15 

No data are available for the time range 
indicated. 

Please choose another time range. 

0x200000
16 

The data are from an unknown device type and 
cannot be read in. 

Please notify Support. 

0x200000
17 

The connected modem could not be initialized.  Please check the connection to the modem 
and try again. 

0x200000
18 

The connected modem does not answer.  Please check the connection and the 
settings. 
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0x200000
19 

General modem error. Please try again. 

0x200000
1A 

Currently not possible to access the device as all 
the available communication channels are busy.  

Please try again. 

0x200000
20 

Device is already being accessed. Please check the manual and automatic 
configuration. 

0x200000
21 

No other device data are available. Please try again later. 

0x200000
22 

Device is already being accessed.  Please check the manual and automatic 
configuration. 

0x200000
23 

Error updating the device time. Possible 
limitations in time synchronization. 

Please try again later. 

0x200000
24 

Another device has been detected. Please check the specified device type. 

0x200000
25 

Incompatible file format found. Please update the Reporting Software. 
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Error messages associated with automatic service: 

 

Error code Problem, cause Remedy 

0x40000000 

The Automatic Service and the Tray Icon 
Application of the Reporting Software are not 
installed. 

Please install the Automatic 
components. 

0x40000001 
The Automatic Service of the Reporting Software is 
stopped. 

Please start the Automatic Service. 

0x40000002 An error has occurred in the Automatic Service. Please check the automatic settings. 
0x40000003 An error occurred when reading out a device. Please check the automatic settings. 

0x40000004 
An error occurred when storing the transmitted 
data. 

Please check the automatic settings. 

0x40000005 
An error occurred when automatically deleting the 
data. 

Please check the automatic settings. 

0x40000006 
No communication possible between the Service 
and Tray Icon. 

Please notify Support.  

0x40000007 
An error occurred when automatically exporting the 
data in binary format. 

Please check the automatic settings. 

0x40000008 
An error occurred when automatically exporting the 
data in XLS or CSV format. 

Please check the automatic settings. 

 

Error messages during database access: 

 

Error code Problem, cause Remedy 
0x60000000 An error occurred when accessing the database. Please check the database settings and the 

database availability. 

0x60000001 Error when accessing the database. Please check the database settings and the 
database availability. 

 

Error messages associated with user administration: 

 

Error code Problem, cause Remedy 
0x600100
00 

The user account has been blocked by an 
administrator. 

Please contact the administrator. 

0x600100
01 

The current user is not an administrator. 
Administrator rights are required for this action. 

Please contact the administrator. 

0x600100
02 

Administrator rights are required. Please contact the administrator. 

0x600100
03 

The password has not been changed. The new 
password was not accepted.  

Please assign a different password. 

0x600100
04 

Password modification has failed. Please assign a different password. 

0x600100
05 

User deletion has failed. Please try again or contact the 
administrator. 

0x600100
06 

User administration cannot be activated as an 
administrator has not been configured. 

Please set up an administrator in the user 
administration function. 

0x600100
07 

User account has been blocked after incorrect 
password entered {0} times. 

Please contact the administrator. 

0x600100
08 

User account has been blocked for 10 minutes 
after incorrect password entered {0} times. 

Please try again after 10 minutes. 

0x600100
09 

Login has failed. Please try again. 

0x600100
10 

Incorrect user ID or password Please try again. 

0x600100 The password has expired and a new password is Please assign a new password. 
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Error code Problem, cause Remedy 

11 required. 
0x600100
12 

Not possible to delete all the administrators if 
user administration is enabled. 

Please disable user administration.  

0x600100
13 

The user currently logged in cannot be deleted.  Please log in under another user name to 
delete this user. 

0x600100
14 

There should always be at least one administrator 
while user administration is enabled! 

Please set up an administrator in the user 
administration function. 

0x600100
15 

The new password and the confirmed new 
password are not identical.  

Please enter the two passwords again. 

0x600100
19 

The new password must differ from the last {0} 
passwords. 

Please assign a different password. 

0x600100
20 

The password must contain at least {0} 
characters.  

Please assign a different password. 

0x600100
21 

The password must contain at least five 
characters.  

Please assign a different password. 

0x600100
22 

The password must contain digits.  Please assign a different password. 

0x600100
23 

The password must contain special characters. Please assign a different password. 

0x600100
24 

The password must contain upper case and lower 
case characters.  

Please assign a different password. 

0x600100
25 

No more users can be created. The Reporting 
Software permits a maximum of 50 users. 

Please delete old user accounts first. 

0x600100
27 

This user ID already exists.  Please assign a different user ID. 

0x600100
28 

User administration cannot be activated as an 
administrator has not been created in the 
database. 

Please set up an administrator in the user 
administration function. 

0x600100
32 

You are not authorized to change the database 
setting. The database setting has not been 
changed. 

Please contact the administrator. 

 

Error messages during data readout: 

 

Error code Problem, cause Remedy 

0x600200
00 

Data storage not successful. The following files 
are corrupted: '{0}' 

Please check the file and/or try again. 

0x600200
01 

Error when accessing the database. The following 
files could not be stored: '{0}'.  

Please try again. 

0x600200
02 

Data storage not successful. The following files 
could not be stored: '{0}'.  

Please try again. 

0x600200
03 

Data readout was not successful. Not possible to 
connect to the device.  

Please try again. 

0x600200
04 

Data readout was not successful. A new device 
could not be created in the database as the 
current user does not have appropriate access 
authorization. The following file could not be 
stored: '{0'} 

Please check your access authorization. 

0x600200
05 

Configurations '{0}' and '{1}' could not be merged 
as data would be lost. 

Please choose other configurations. 

0x600200
06 

The configurations could not be merged as there 
is a time overlap between configurations '{0}' and 
'{1}'. 

Please choose other configurations. 

0x600200
07 

Cannot establish connection to the database 
server!  

Please check the settings. 
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0x600200
08 

Not possible to connect to the database server 
with the new settings. The changes to the 
database settings are not accepted! 

Please check the settings. 

0x600200
09 

Invalid database settings Please check the settings. 

0x600200
10 

Files not deleted successfully.  Please delete the data manually. 

0x600200
11 

The data that have been read out could not be 
deleted from the device. 

Please delete the data manually. 

0x600200
12 

An error occurred when connecting to the device.  Please check the communication settings 
and try again. 

0x600200
13 

The devices could not be merged because device 
'{0}' and device '{1}' are different types of device. 

Please choose two devices of the same 
type. 

0x600200
14 

The devices could not be merged as there is a time 
overlap between devices '{0}' and '{1}'. 

Please choose two devices that do not 
overlap timewise. 

0x600200
15 

A new node could not be added.  Please try again. 

0x600200
16 

Node addition has failed. Please try again. 

0x600200
17 

Impossible to add a new node. Please log in with a higher-level user role 
(e.g. administrator). 

0x600200
18 

Add node Please log in with a higher-level user role 
(e.g. administrator). 

0x600200
19 

The selected node may not be deleted. Please log in with a higher-level user role 
(e.g. administrator). 

0x600200
20 

Delete node Please log in with a higher-level user role 
(e.g. administrator). 

0x600200
21 

The selected node may not be moved. Please log in with a higher-level user role 
(e.g. administrator). 

0x600200
22 

Move node Please log in with a higher-level user role 
(e.g. administrator). 

0x600200
23 

The selected node may not be renamed. Please log in with a higher-level user role 
(e.g. administrator). 

0x600200
24 

Rename node Please log in with a higher-level user role 
(e.g. administrator). 

0x600200
25 

A new node could not be created.  Please check the settings. 

0x600200
26 

Node creation has failed. Please check the settings. 

0x600200
27 

The selected node could not be deleted. Please check the settings. 

0x600200
28 

Node deletion has failed. Please check the settings. 

0x600200
29 

Node deletion has failed. Try again. You might have to increase the 
timeout value in the database connection. 

0x600200
30 

The selected node could not be deleted.  Try again. You might have to increase the 
timeout value in the database connection. 

0x600200
32 

An error occurred during the import. {0} of {1} 
lines have not been imported! 

 

0x600200
34 

The selected node could not be moved. Please check the settings. 

0x600200
35 

Not possible to move the node. Please check the settings. 

0x600200
36 

Unable to open the file '{0}'! Please check whether the file can be read. 

0x600200
37 

The plant view could not be refreshed. Please check the settings. 
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0x600200
38 

Plant view refresh has failed Please check the settings. 

0x600200
39 

The template view could not be refreshed. Please check the settings. 

0x600200
40 

Template view refresh has failed Please check the settings. 

0x600200
41 

The selected node cannot be renamed.  Please make sure that the name is not 
longer than 30 characters. 

0x600200
42 

Node renaming has failed. Please make sure that the name is not 
longer than 30 characters. 

0x600200
43 

Failure to update the communication settings. Please check the settings. 

0x600200
44 

Failure to update the communication settings. Please check the settings. 

0x600200
45 

Cannot establish connection to the database 
server. Database scheme has not been generated. 

Please contact your administrator. 

0x600200
46 

Invalid communication settings!  Please select "Back" and change the 
communication settings. 

0x600200
47 

Configuration merge has failed. Please try again or select other 
configurations. 

0x600200
48 

Device merge has failed. Please try again or select other devices. 

0x600200
49 

There are no communication settings for the 
selected device. 

Please change the communication settings 
for the selected device. 

0x600200
50 

No files available with data. Please select another directory. 

0x600200
51 

An error occurred when reading the device 
information.  

Please check the connection and try again. 

 

Error messages during export: 

 

Error code Problem, cause Remedy 

0x600300
00 

Finished with an error. Try again. 
Click 'Close' to exit the Wizard. 

0x600300
01 

Finished with an error. 
The data have been exported from the database 
but could not be deleted. 

Click 'Close' to exit the Wizard. 

0x600300
02 

There are no data in the database for the selected 
time range. No file has been generated. 

Please choose a valid time range. 

0x600300
03 

The selected template contains devices that are 
no longer available in the database.  

Please delete the template. 

0x600300
04 

Missing devices Please delete the template. 

0x600300
05 

The selected template contains at least one device 
that is no longer in the database. 

Please delete the template. 

0x600300
06 

Missing device Please delete the template. 

0x600300
07 

The selected template is no longer in the 
database. It has probably been deleted in the 
meantime. 

Please choose another template. 

0x600300
08 

Template not available Please choose another template. 

0x600300
09 

You cannot open this template as you do not have 
access authorization for at least one device in this 
template.  

Please contact the Reporting Software 
administrator. He/she can assign you the 
necessary authorization. 
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0x600300
10 

No access authorization Please contact the Reporting Software 
administrator. He/she can assign you the 
necessary authorization. 
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Error messages during import: 

 

Error code Problem, cause Remedy 

0x600400
00 

The binary file has been saved with a more recent 
version of the Reporting Software and cannot be 
imported. 

Update the Reporting Software to the 
current version. 

0x600400
01 

Finished with an error. No data have been 
imported. 

Please check the import file. 
Click 'Close' to close the Wizard. 

0x600400
02 

Finished with a warning. Some data could not be 
imported. 

Click 'Close' to exit the Wizard. 

0x600400
03 

Import not successful. The import file indicated 
does not contain any data. No data have been 
imported.  

Please check the file. 

 

Error messages associated with visualization: 

 

Error code Problem, cause Remedy 

0x600500
00 

The changes to the automatic function cannot be 
saved as the template has not been saved! 

Please save the template. 

0x600500
01 

An error occurred when saving the template. The 
template was not saved in the database. 

Please check the database settings. 

0x600500
02 

Error when saving the template. Please check the database settings. 

0x600500
03 

An error occurred during the export. Export was 
not successful. 

Please check whether there is sufficient 
space in the selected directory and whether 
you have write-access for this directory. 

0x600500
04 

The "Minimum" value must be smaller than the 
"Maximum" value! 

Please correct the values chosen. 

0x600500
05 

There are no data in the database for the selected 
time range. 

Please choose another time range. 

0x600500
06 

No data available Please choose another time range. 

 

Error messages associated with the installation or database: 

 

Error code Problem, cause Remedy 

0x600600
00 

The Demo version test period has expired. You 
cannot start this application any more.  

Please order a serial number for the full 
version.  

0x600600
01 

The Demo version test period has expired. You 
cannot start this application any more.  

Please order a serial number for the full 
version.  

0x600600
02 

The license information is incorrect. Please start the installation program again. 

0x600600
03 

The license information is incorrect. Please start the installation program again. 

0x600600
04 

The new language setting is enabled once the 
program has been restarted.  

Please start the Reporting Software again. 

0x600600
05 

The new language setting is enabled once the 
program has been restarted.  

Please start the Reporting Software again. 

0x600600
06 

There is no valid database on the database server 
that is currently connected, or the wrong version 
of the database is available.  

Please contact your administrator. 

0x600600
07 

Incorrect database Please contact your administrator. 
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Error messages during printout: 

 

Error code Problem, cause Remedy 

0x600700
00 

The document requires more than 1000 pages. Please select a shorter time frame to avoid 
this problem. 

0x600700
01 

Document creation was stopped after 1000 pages 
because the maximum number of pages has been 
reached.  

Please select a shorter time frame to avoid 
this problem. 
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9. Appendix  

9.1 Reporting  

The "Reporting" task area contains functions to create and edit dashboards (reports) and to 

manage report projects. 

An icon with the name defined by the user is displayed for every dashboard saved. The items are 

sorted alphabetically. 

NOTICE  
If user administration is enabled, the only dashboards displayed are those available to the user 

role of the user that is logged in. 

The final items in the Reporting section are for creating new dashboards, assigning dashboards to 

user roles (only if user administration is enabled) and for managing report projects. 

Reports are created from stored measured values. Clicking on the required dashboard opens the 

reports in a working window in the right half of the screen. 

NOTICE  
The "Reporting" section is only available if the license was ordered with the reporting 

functionality (optional). 

Use of the reporting functionality is not possible if security requirements in accordance with 

FDA21 CFR Part 11 are enabled. 

 

9.1.1 User roles  

User roles determine rights within Reporting if user administration is enabled. There are only two 

types of user role within Reporting; "Administrator" and "User". 

The table below shows the relation between FDM user roles and reporting roles and the impact 

within reporting: 

 

Responsibility Adminis

trator 

Service 

Engineer 

Planning 

Engineer 

Maintenan

ce 

Engineer 

System 

Operator 

Observer 

Administrator in Reporting X  X X   

User in Reporting     X X 

Open dashboards X  X X X X 

Create public dashboards X  X X   

Assign public dashboards X  X X   

Create private dashboards     X X 

Manage report projects X  X X   

All reports are available X  X X   

Available reports 

configurable 

    X X 

       

Access to individual devices or plant sections of the user is also valid in Reporting. A user may 

thus have access to a specific dashboard. However, if access is not allowed to the device used, no 

data are displayed. 
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9.1.2 Creating a new dashboard 

 

A new dashboard is created by clicking on "New" in the task pane under "Reporting". 

Dashboards can be public or private. As a general rule, "Administrators" create public dashboards 

in Reporting and "Users" private dashboards (see 9.1.1 User roles).  

 Private dashboards are only visible to the person who creates them and can only be edited 

or deleted by this person. 

 Public dashboards are visible and can be edited by all "Administrators“ in Reporting. Public 

dashboards can be made visible to "Users" using the "Assign Groups" function. 

If user administration has been disabled, only public dashboards that are visible to everybody are 

created. 
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9.1.2.1 Step 1 of 4: Create a dashboard  

A name must be entered for a new dashboard and the report(s) to be displayed must be selected 

(by clicking on "Add a report"). 

 

 

9.1.2.2 Step 2 of 4: Add a report  

Reports are grouped into subject areas. The standard reports provided are described in Section 

9.2.1 Standard reports.  

There are two different types of report: 

1. Overview reports: These can be grouped as small "Tiles" on a dashboard (e.g. to 

compare a number of similar plants). The overview reports generally contain links to 

further detailed reports which are then displayed in full-screen size. 

2. Detail reports: These full-screen detail reports can only be displayed on their own 
on a dashboard. If an overview report is already selected on a dashboard, a full-
screen report cannot be added. 
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9.1.2.3 Step 3 of 4: Configure report  

Most of the reports contain various parameters which can be configured. 

 

The first parameter "Name" is the report title in the dashboard. The name of the template is used 

(e.g. "Compressor Efficiency (small)" ) if no name is entered. 

The function of the remaining parameters in standard reports is explained in Section 9.2.1 

Standard reports.  

9.1.2.4 Step 4 of 4: Assign groups, configure layout and save  

To complete creation of a new dashboard, groups can be assigned to the dashboard (only makes 

sense if user administration is enabled).  

Furthermore, the layout of the dashboard can be adapted using the "Configure" option. 

Finally the dashboard must be saved by clicking on "Save". 

9.1.3 Opening/editing a dashboard  

All of the available dashboards are displayed in the task pane in alphabetical order. 

A dashboard is opened on the right-hand side of the working window by clicking on it. 

A dashboard can be changed or deleted if user administration has been disabled, if the logged in 

user belongs to the administrator group in the Reporting section or if a private dashboard was 

opened. The functions for changing are identical to those when creating a dashboard. 

 

9.1.4 Printing a dashboard, exporting a dashboard as a file  

There are various ways of printing a dashboard. The page shown in FDM is similar to a web site 

which is opened in a browser. And, similar to a web site, the displayed content of the dashboard 

can be printed out. This is done by clicking on the printer symbol in the tool bar of the open 

dashboard.  

The page is then sent to the printer as displayed. If a full-screen report is not completely visible on 

the screen, then it will also be cropped in the printout. Multi-page reports cannot be printed out 

completely in this way. 

Alternatively, the report itself can be exported as a file and then saved and printed. There are 

various formats available for exporting; however, images, graphics and diagrams are displayed 

differently in some cases. PDF format displays the report practically identical to the way it is 

shown on the screen. 
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To create the report as a PDF, select the "Export Content" function. 

In the case of overview reports (tiles), right-click on the report for this function: 

 

 

For full-screen reports, this function is called up using the  menu icon. 

 

A menu then opens from which you can select the export format (file format). If necessary, the 

page settings can also be adjusted (e.g. selection of the pages to be exported can be adapted for 

multi-page reports). 
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Clicking on OK opens a dialog to save the file. 

 

9.1.5 Page navigation for multi-page reports  

The buttons at the top of the report are used to navigate between the pages in multi-page reports. 

You can enter the required page number in the edit box or use the arrows to go to the 

previous/next page or to the first/last page. 

 

9.1.6 Assigning dashboards 

This function is only available if user administration is enabled and the user is logged in as an 

administrator in the Reporting section. 

 

The available dashboards are listed. For every user role within FDM (referred to as groups here), 

you can select whether the dashboard is visible for a group or not. 

If a dashboard contains reports which are not available to the group, an appropriate message is 

displayed and the reports can be made available to the group. 
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9.1.7 Editing report projects 

A selection of standard reports are installed when the reporting framework is installed. The 

reports are grouped into "Projects". Other report projects are included on the FDM installation 

medium, e.g. for rain spillway basins. Furthermore, Endress+Hauser can create special user-

specific reports. 

Click on "Report Projects" in the task pane to access Report Project Administration. 

 

You can upload new projects or newer versions of available projects in this section or edit existing 

projects. You can also delete projects that are not required. 

9.1.7.1 Uploading report projects 

Report projects are uploaded by dragging & dropping the project file into the gray area. 

After a successful check of the project file, the project can be configured by clicking on "Next" 

(top, right of window). 
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The available reports of the project are listed in the next step.  

 

The reports contain one or more database connections. The database connection is not yet set in 

new report projects. The connection settings can be entered using the "Edit" field and tested.  

No adjustment is necessary for connections with the name "FDM_conn". This is carried out 

automatically when you click on "Finish". 
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The reports of the project can be made available to the user groups in the final step. Those with 

administrator access to Reporting always see all reports. 

 

 

9.1.8 Troubleshooting 

Problem, cause Remedy 

Report shows the message:  
"No channel selection file could be found. Please 
configure the report through this link." 

The channels of a device in the FDM database must be 
selected for the report. The file stored during this process 
could not be found or was not yet created.  
Open channel selection by clicking on the link, select channels 
and save the file (see 9.2.1.2). 

Report shows the message: 
"The used configuration is not the latest one, 
changing the configuration might be required." 

The channel selection file does not point to the most recent 
device configuration. It may be necessary to open channel 
selection and modify accordingly. 
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Report shows the message: 
"Data is not available, maybe due to restricted 
user's access rights." 

No measured values could be loaded. There are a number of 
possible reasons for this:  
1. There are no measured values in the FDM database for 

the selected time period  Change the time period or 
read values from the device again and open the report 
once more 

2. The logged in user does not have the authorization to 
view data for the selected measuring device.  Change 
user rights or log in as a different user. 

Report shows the message: 
"Table contains manipulated data." 

Verification of the data has shown that measured values in 
the database may have been manipulated. 

Report shows the message:  
"Verification of data is switched off. Manipulated 
data cannot be recognized.” 

Verification of the data to check for manipulation has been 
switched off. This means the report can be displayed faster.  
This is for informational purposes only in case verification is 
not required. No further action is necessary. 

Report shows the message: 
"Device and/or Configuration do not match, please 
verify channel selection and save it." 

The device or the configuration is not identical to the saved 
file selected. The configured channels must be checked. 

Report shows the message: 
"Version of saved channel selection file does not 
match the report version. Please verify channel 
selection and save it.“ 

Channel selection must be checked. If the channels are 
correctly selected, save the settings. 

Report shows the message: 
"Changed channel selection can only be saved by 
its creator or users of roles Administrator, 
Planning Engineer and Maintenance Engineer.“ 

Users with "System Operator“ and "Observer" roles can only 
save the channel selection if they created it themselves. 
Please log in as a different user. 

 



9 Appendix 

129 

9.2 Reports provided as standard 

9.2.1 Standard reports 

A number of standard reports are provided when the reporting functionality is installed. They are 

available directly after installation. 

NOTICE  
Other reports can be loaded subsequently. For further details, see 9.1.7.1 Uploading report 

projects 

9.2.1.1 Report parameters 

Depending on the report, different parameters can be configured in order to determine the 

information displayed or the time period.  

Most standard reports use the following parameters: 

 

"Report Name" 

Channels must be defined for the report in all standard reports (device selection from the FDM 

database and channel assignment). This assignment is saved in a file on the report server. The 

reference between the report and the channel selection file is the "Report Name" parameter. 

Please refer to Section 9.1.2 Creating a new dashboard for information on how to configure the 

parameters. For example, if reports for one steam boiler are to be displayed in different 

dashboards, the "Report Name" parameter must be identical for each report in order to use the 

same assignment. 

"Deactivate verification" 

The "Deactivate verification" parameter is available for most standard reports. This parameter 

allows users to control whether the data displayed in the report is to be checked for manipulation. 

Verification for manipulation can be very resource-intensive and can therefore be switched off in 

order to speed up the report loading time. A message appears in the report to this effect. 

"Date" 

Up to four parameters are available to set the date range for a report. If a fixed time frame is to be 

used, enter it in the "Date from" and "Date to" text parameter. When doing so, please pay 

attention to the format [year four digits]-[month two digits]-[day two digits] [hour two digits, 

optional]-[minutes two digits, optional]. 

Example: 1 February 2016 must be entered as: "2016-02-01" 

If the "Date from" and "Date to" parameters are set, the "Time range" and "This or Previous" 

parameters are ignored. If only one of the parameters "Date from/to" is set, the "Time range" 

parameter is also used to calculate the time frame. 



9 Appendix 

130 

9.2.1.2 Channel assignment 

If reports are to be displayed correctly, the user must select the device in the FDM database to be 

used and which channels of the device are to be used in the report.  

A special report is used to assign both. This is saved in a file on the report server. 

If user administration is enabled, an existing file can only be changed by users with 

"Administrator in Reporting" access rights or by the user who created the file. 

If there is no mapping file available for a report, a message to this effect appears in the report. No 

measured values can be displayed in the report in this case. The message text acts as a hyperlink 

to the configuration at the same time. 

In channel assignment, a device from the FDM database must first be selected and a 

configuration. The Sankey report is an exception here and is described in more detail in Section 

9.2.1.6. 

The channel assignment report shows a schematic diagram of the plant in the background (e.g. 

steam boiler or cooling generator). Selection fields are arranged on top of this which allow users 

to select and assign measuring channels to specific functions in the report. The function appears 

first in the selection list (in the graphic below e.g. the function is "Steam mass", and the selected 

channel is "Steam mass [t])". 

If a function remains selected on the description (the first option in the selection list), this means 

the function is not considered to be set and cannot be displayed in the report. In the graphic 

below, for example, "Blowdown Mass" is not measured in the process and should therefore not 

appear in the report. 

The channels of the device are displayed with the appropriate unit in square brackets. 
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9.2.1.3 Steam boiler efficiency 

Various reports are available for steam boilers. 

Overview (small tile) 

An overview report is available (like a small "tile") in which a summary of the main key 

performance indicators is displayed. A number of these tiles can be shown together on one 

dashboard to provide an overview of several boilers for example. Hyperlinks in the report enable 

you to access other reports within this area. 

 

 

 

The average steam quantity by day and efficiency of the boiler are displayed. 

There are also full-screen reports with more detailed information. These reports are available for 

the following time ranges: week, month, year (or 12 months). 
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Annual report, page 1 

 

1: Report name 

2: Time period of the report and time stamp from when the report was created 

3: Navigation area to jump forward/backward within the time range, or link to channel selection 

(not available as a PDF) 

4: Schematic diagram of a steam boiler showing totals for steam, fuel and feedwater if applicable, 

blowdown; average values for efficiency, pressure, temperature. 

The information displayed here can vary depending on the channels/measured values selected. 

For example, a second KPI (Key Performance Indicator), the specific fuel consumption may be 

displayed. 

5: Diagram showing monthly consumption of steam and fuel 

6: Table showing monthly consumption and efficiency with the date as a hyperlink to the 

monthly report (no hyperlinks in the PDF) 

7: Diagram showing the monthly efficiency calculated and specific consumption where applicable 
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Annual report, page 2 

 

1: Diagram and table showing steam consumption for the current year compared to the previous 

year 

2: Diagram and table showing efficiency for the current year compared to the previous year 

 

Monthly report, page 1 

The structure of page 1 of the monthly report is comparable to the annual report. The difference 

is that the information displayed in both the diagram and table is day-based; the hyperlink in the 

date links to the weekly report. 

Monthly report, page 2 
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The second page of the monthly report is similar to a calendar view with diagrams on daily steam 

consumption. 

Weekly report, page 1 

The structure of page 1 of the weekly report is comparable to the annual report but the 

information displayed in both the diagram and table is day-based. 

Weekly report, page 2 ff. 

The second (and subsequent) pages of the weekly report contain a diagram with detailed boiler 

data for each day. All of the channels configured in channel selection are displayed. 

The channel can be shown/hidden by clicking on the channel name in the legend for each 

diagram. 
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9.2.1.4 Compressed air compressor efficiency 

Various reports are available for compressors. 

Overview (small tile) 

An overview report is available (like a small "tile") in which a summary of the main key 

performance indicators is displayed. A number of these tiles can be shown together on one 

dashboard to provide an overview of several compressors for example. Hyperlinks in the report 

enable you to access other reports within this area. 

 

 

The average quantity of compressed air per day and the specific energy consumption (SEC = 

Specific Energy Consumption) are displayed. 

There are also full-screen reports with more detailed information. These reports are available for 

the following time ranges: week, month, year (or 12 months). 
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Annual report, page 1 

 

1: Report name 

2: Time period of the report and time stamp from when the report was created 

3: Navigation area to jump forward/backward within the time range, or link to channel selection 

(not available as a PDF) 

4: Schematic diagram of a compressed air compressor showing totals for compressed air 

consumption, electricity; pressure minimum/maximum and average values; specific energy 

consumption (SEC, Specific Energy Consumption). 

The information displayed here can vary depending on the channels/measured values selected. 

For example, the leakage can be shown. 

5: Diagram showing monthly consumption of compressed air and electricity 

6: Table showing monthly specific energy consumption and leakage where applicable with the 

date as a hyperlink to the monthly report (no hyperlinks in the PDF) 
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7: Diagram showing the monthly specific energy consumption calculated and leakage where 

applicable 

 

Annual report, page 2 

 

1: Diagram and table showing compressed air consumption for the current year compared to the 

previous year 

2: Diagram and table showing specific energy consumption (SEC) for the current year compared 

to the previous year 

 

Monthly report, page 1 

The structure of page 1 of the monthly report is comparable to the annual report. The difference 

is that the information displayed in both the diagram and table is day-based; the hyperlink in the 

date links to the weekly report. 
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Monthly report, page 2 

 

The second page of the monthly report is similar to a calendar view with diagrams for daily steam 

consumption. 

Weekly report, page 1 

The structure of page 1 of the weekly report is comparable to the annual report but the 

information displayed in both the diagram and table is day-based. 

Weekly report, page 2 ff. 

The second (and subsequent) pages of the weekly report contain a diagram with detailed boiler 

data for each day. All of the channels configured in channel selection are displayed. 

The channel can be shown/hidden by clicking on the channel name in the legend for each 

diagram. 
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9.2.1.5 Cooling machine efficiency 

Various reports are available for cooling generators. 

Overview (small tile) 

An overview report is available (like a small "tile") in which a summary of the main key 

performance indicators is displayed. A number of these tiles can be shown together on one 

dashboard to provide an overview of several cooling machines for example. Hyperlinks in the 

report enable you to access other reports within this area. 

 

The average cooling energy per day, the average power consumption per day and the specific 

energy consumption (SEC = Specific Energy Consumption) are displayed. 

There are also full-screen reports with more detailed information. These reports are available for 

the following time ranges: week, month, year (or 12 months). 
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Annual report, page 1 

 

1: Report name 

2: Time period of the report and time stamp from when the report was created 

3: Navigation area to jump forward/backward within the time range, or link to channel selection 

(not available as a PDF) 

4: Schematic diagram of a cooling compressor showing totals of cooling energy, cooling 

compressor electricity, condensator electricity; COP (Coefficient of Performance) and COP2 

where applicable (if configured on the Memograph M) 

5: Diagram showing monthly consumption of cold and electricity 

6: Table showing monthly energy consumption and COP with the date as a hyperlink to the 

monthly report (no hyperlinks in the PDF) 

7: Diagram showing the monthly COP (and where applicable COP 2) calculated 
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Annual report, page 2 

 

1: Diagram and table showing cold for the current year compared to the previous year 

2: Diagram and table showing COP for the current year compared to the previous year 

 

Monthly report, page 1 

The structure of page 1 of the monthly report is comparable to the annual report. The difference 

is that the information displayed in both the diagram and table is day-based; the hyperlink in the 

date links to the weekly report. 
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Monthly report, page 2 

 

Weekly report, page 1 

The structure of page 1 of the weekly report is comparable to the annual report but the 

information displayed in both the diagram and table is day-based. 
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Weekly report, page 2 ff. 

The second (and subsequent) pages of the weekly report contain a diagram with detailed cooling 

machine data for each day. All of the channels configured in channel selection are displayed; i.e. 

the pressure/temperature of the coolant (if configured). 

The channel can be shown/hidden by clicking on the channel name in the legend for each 

diagram. 
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9.2.1.6 Sankey 

A Sankey diagram is a graphic representation of quantity flows. Unlike a flow diagram, quantities 

are illustrated as arrows. The width of the arrow is proportional to the size of the flow.  

 

A Sankey diagram consists of "nodes" (the rectangles) which are connected by "links". The 

elements in the Sankey diagram are automatically placed in position when it is created; the nodes 

can however be moved. 

Clicking on a link opens the consumption diagram associated with that link. 

 

9.2.2 Rain spillway basins 

A special report for rain spillway basins (in accordance with BayLfW 2001/2006 [ 7], [10]) is 

included in the installation files; it is not installed as standard however. 

Proceed as described in Section 9.1.7.1 to be able to use this report.  

9.2.3 Specific reports 

In principle reports can also be created by customer request. For more detailed information, 

please contact your Endress+Hauser sales office. 
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